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Window Reference

 

The Mixing Desk

 

The Mixing Desk is the first window that appears when SonicStudio

 

™

 

 
completes its start-up. Use it to direct the input and output of sounds, 
controlling their gain, equalization and channel separation.
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The Mixing Desk consists of two separate principle windows, the 
channel fader section and the master output section.

 

Channel Fader Section

 

Channel Faders control the input level and equalization of soundfiles 
during playback and recording. These channel input strips can be 
grouped and routed in various configurations.
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The number of channel strips available depends on system 
configuration. Systems that use a single SSP-3 board show four channels. 
An additional four channel strips are added for each additional SSP-3.

Each channel input strip has a fader, an individual pan pot controlling 
direction, pre-fader level meter, two or four sections of equalization, 
input and output routing switches, insert point for real-time DSP 
options, and mute/solo/phase invert switching.
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Selecting Channel Inputs and Outputs

 

The two buttons at the top of the channel strip are used to select the 
audio source going into the channel and to route audio from the channel 
out.

 

Input/Output Assign 

Input and Output
Select

Filter / Dynamics
Sections

Solo, Mute, and
EQ Defeat

Pan

Channel Fader
and Metering

Phase Invert

Channel Insert

Output Bus Select

Channel Input Select
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The input and output assign buttons operate by click-holding on either 
button. This brings up a pop-up menu listing available selections. A two-
character label indicates the signal currently selected.

 

Output Bus Select

 

Click-holding on a channel’s output bus select (“O”) button brings up a 
pop-up menu to route that strip’s output to one of the available mix 
buses. A selection of “X - Off” selection means there is no assignment for 
that channel. The number of output buses available depends upon 
system configuration, with a minimum of two output buses, M1 and M2.

The output buses correspond to particular outputs on the SSP-3 or USP 
hardware. In a single-board SSP-3-based system, for example, M1 and 
M2 correspond to the left and right channels of the topmost output 
(“P2”) connector.

 

Channel Input Select

 

Click-holding on the input select (“I”) button brings up a list of 
selections.
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L1-L4Line Inputs

 

Each channel has a selection of two or four inputs, depending upon 
system configuration. In systems with more than four inputs and 
channel fader strips, each group of four accesses a different group of 
inputs. In an 8-input, 8-fader system channels 1-4 have access to line 
inputs L1 through L4, while the pop-ups for channels 5-8 list L4 through 
L8 as the available inputs.

 

Channel Cascade Inputs

 

In this version, mixing desk channels may be cascaded one into another 
in stereo pairs. The operation of cascade is according to channels pairs, 
going from right to left. For example, you can cascade channels 3 and 4 
into channels 1 and 2. Or you can cascade channels 5/6 into 3/4 and 
additionally cascade those two channels into 1 and 2.

The figure above illustrates cascading channels 5/6 into channels 3/4 
while also cascading 3/4 into 1/2. The channel outputs are set to follow 
the channel number, i.e. channel 5 is set to M5. The channel inputs for 
each channel that is being cascaded into are set to C

 

n

 

, as shown above. 
Note that you can only cascade pairs of channels in a right-to-left order.

 

A1-A4Audition (Disk) Channels

 

SonicStudio provides a number of audition buses coming from the 
sound disk. For playback, individual panels in the EDL are assigned to 
these audition channels and these are selected at the Mixing Desk’s 
channel strips.

Set channel in to
C1/C2 for channels
cascaded INTO

Set channel out
to match channel
number
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B1-B4Rolloff Channels

 

The Rolloff channels correspond to the Dump port selected in Audio I/O 
Preferences

 

 

 

(see next chapter), so you can monitor output during 
background dumps.

 

Selecting and Adjusting Filters and Dynamics

 

The Filter/Dynamics portion of each channel strip consists of two or 
four individual sections. These are displayed as 3-dimensional “tiles.” 
You can open and set any of these filter sections by double-clicking on 
the corresponding tile.

To select a filter:

 

•

 

Double-click on the filter square you want to set.

An adjustment window appears, with a menu bar for selecting the filter 
type and rotary adjust knobs to set the parameter values.

To select the filter type: 

 

•

 

Click-hold on the upper strip of the window.

The filter list that appears lists all filter types available. The selection of 
processing types depends on system configuration.

To set filter parameters:

 

Click-Hold to group Filters

Click-Hold to select filter type
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•

 

Use the knobs or nudge buttons to set the filters as desired.

For fine adjustment, hold down the Shift key as you click on the 
parameter adjust knob. The range of travel of the mouse will be 
extended, allowing for very find adjustment.

Though the controls are displayed as knobs, you do not need to use a 
rotary motion. Just click on the desired control and move the mouse left 
and right, as though it were a slider. The knob will follow your motions.

 

Filter Grouping

 

Filters may be grouped as desired, no matter whether the sections are 
adjacent or not.

To assign a filter section to a group:

 

1. Click-hold on the topmost strip of the window.

2. Make a selection from the pop-up menu.

 

Sections that are assigned to the same group will follow each other’s 
settings. Adjusting any one filter will cause all others in the same group 
to change as well.

You can open and display any number of individual filter setting 
windows. You can move these on the screen and arrange them into 
groups as desired. Once a filter or dynamics processing type is selected, 
you may close that filter’s setting window. The selected parameter 
values for the filter are displayed within the filter’s square on the main 
channel fader section.
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Filter Types and Parameters

 

Parametric (Presence) Filter

 

The parametric (presence) filter boosts or attenuates a particular region 
of the audio spectrum, with three variable parameters:

 

Center Frequency

 

The center frequency is the mid-point of the band affected. The center 
frequency may be selected over a range of 1.0 Hz to 22.050 kHz

 

Q

 

Filter Q may be translated into actual bandwidth in hertz using the 
formula BW = Freq/Q. The range is from 0.1 to 100.

 

Boost/Cut 

 

B/C indicates the amount of gain or attenuation that will be applied at 
the center frequency, with a range of 

 

±

 

24 dB.

 

High and Low Shelving Filters

 

Shelving filters apply a fixed boost or cut to frequencies beyond the 
cutoff frequency.

 

Frequency Response of Presence Filter
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Cutoff Frequency

 

Cutoff frequency in the shelving filters is the point where the affected 
signal is boosted or cut by 3 dB, or by 1/2 the specific boost/cut, 
whichever is less. The range is 1 Hz to 22.050 kHz.

 

Boost/Cut

 

Boost or Cut applies to signal above (in the case of hi shelf) or below (in 
the case of lo shelf) the cutoff frequency. The range is 

 

±

 

24 dB.

 

Order

 

The “Order” of a filter (value from 1 to 4) controls the slope of the filter’s 
response curve, with 6 dB octave for each integer step. Higher values of 
Order consume larger amounts of SonicStudio’s signal-processing 
power.

Additional filter types are available with the Mixing Desk Option SS-201 
that is included on many systems. Refer to the SS-201 manual for details 
on these filters.

 

Solo, Mute, and EQ Defeat

 

At the base of each channel’s filter section is a group of three buttons 
that select solo, mute, or EQ defeat for the channel.

The Solo button selects a single strip for output or auditioning by 
muting the other channels.

 

Frequency Response of High and Low
Order Shelving Filters
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The Mute button turns off the output of the affected channel. If solo is 
active when mute is selected, the solo is turned off.

EQ Bypass switches all filters in the channel strip. With the EQ bypass 
activated, the channel has a completely flat frequency response.

 

Panning

 

Each channel strip has a pan pot that controls the routing of signal 
between the pairs of output buses (M1/M2 or M3/M4).

Though the pan pot is shown as a rotary knob, use a simple left-right, 
rather than rotary, motion to adjust its setting.

 

Channel Fader, Meter, and Phase Invert

 

The channel fader sets the amount of gain or attenuation applied to the 
post-EQ signal. It is capable of supplying up to +20 dB of gain, or 
attenuation down to infinity.

"Nudge" Buttons

"Hot Spots"

Current Value

Pan Knob
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As the slider is adjusted, the readout window at the top displays gain in 
decibels. “Hot spots” to the right of the slider can be used to quickly set 
the gain to unity, +20 dB, or infinite attenuation.

Nudge buttons at the bottom of the slider move gain in increments of 
1/10 dB. Signal phase is controlled by clicking on the “Phase Invert” 
(+/-) symbol to the left of the nudge buttons and immediately below the 
channel meter.

Individual “pre-fader” meters are provided on each fader strip. These 
display the level of signal coming into the fader.

 

Channel Grouping

 

The mixing desk provides flexible grouping of channel faders, with any 
fader assignable to one of eight fader groups

To assign a fader to a group:

 

1. Hold down the option key and click-hold on the “handle” of the 
channel fader.

2. Select a group from the pop-up menu that appears.

Slider Knob

Channel Meter

Phase Invert

Current Value

"Hot Spots"

"Nudge" Buttons
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Whenever a fader assigned to a group is moved, all faders assigned to 
the same group move with it. If the faders in a group are set differently 
at time of assignment, they preserve the same offset as they move. If any 
faders reach the end of travel in any direction owing to movement of 
another fader in that group, they are pegged at maximum or minimum 
setting. The original offset is restored as soon as the faders are moved 
away from the “clipped” position.

 

Channel Insert

 

The channel insert button at the base of each channel is used to insert 
signal processing options, such as effects and NoNOISE, in line with the 
channel. The Insert Point Select button calls up a pop-up menu listing 
four insert points (I1-I4), and the default setting (X-No insert).

Channel inserts are used for real-time signal processing options such as 
denoise and reverberation. If these options are not included in the 
system, the channel inserts do not operate.

 

Master Output Section

 

The Master Output section provides a pair of faders to control overall 
output level, two assignable output meters, and control of output mode 
(mono or stereo).
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The master output section is a separate, Macintosh-standard window. It 
may be placed, scrolled, or resized independently of the channel fader 
section.

 

Output Mode

 

The output mode pop-menu determines whether SonicStudio functions 
as a stereo or monaural system.

Output Mode
Meter Assignment

Master Output
Meters

Current Value

Channel Faders
and Meters
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If Stereo is selected, the pan pots are active, and the signals from the left 
and right buses are routed accordingly. In the Mono (Mix)

 

 

 

setting, the 
two sides of the stereo mix are combined. Both outputs, left and right, 
see the same signal. In Left->Right

 

 

 

mode, the left side of the stereo mix is 
routed to the right side as well, yielding a mono output.

 

Meter/Fader Assign

 

The meter/fader assign button selects a pair of mix outputs. The selected 
pair then functions as the “main” stereo output, with gain control from 
the master faders and output level shown on the output meters.

Click-holding on this button brings up a list of the available selections. 
The length of the list depends on system configuration, with the smallest 
systems providing only a single possible assignment.

 

Output Level Meters

 

The Meters section provides visual confirmation of audio signal levels 
output from the Mixing Desk buses.

Peak Hold

Left/right output
meters
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Peak Hold Check Boxes

 

The meters show instantaneous and peaking (3 second maximum 
values) signals in bright and light green, respectively. Selecting peak 
hold causes the meter(s) to hold the highest value indefinitely.

 

Left and Right Meters 

 

Each meter provides a reading of the full scale of digital audio, from 
minus infinity to 0 dB, where 0 is one bit-value less than full scale. The 
overload indicator on each meter lights if the signal actually reaches full 
scale.

 

Master Faders

 

The master faders provide signal attenuation only, from 0 dB of 
attenuation down to infinity.

The readout box at the top indicates actual attenuation as the sliders are 
adjusted. “Hot Spots” to the right of the slider quickly set level to “0” 
(off) or full scale, while the nudge buttons at the bottom change 
attenuation in small increments.

The output faders may be locked together for stereo fading as with the 
channel faders and pan pots. Simply hold down the Option key and 
click-hold on one of the fader handles. A pop-up submenu will appear to 
allow the faders to be locked or unlocked. (They are locked by default on 
initial start-up.)

Gain Value
Fader Handle

"Nudge" Buttons

"Hot Spots"
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Mix Desk Automation

 

The automation functions of the Desk are controlled entirely by menu 
commands

To begin a desk automation Session:

 

•

 

From the File menu, select the command New Desk Session

When you create a new Desk Session, the name of the Session appears at 
the top of the Desk’s Channel Fade section, and the commands in the 
Automation section of the Desk menu become active.

 

Automation

 

Select this command to active mix automation. When you select this 
command, a check mark will appear beside it in the menu. So long as 
this check mark shows, automation is in effect.

With automation activated, changes to the Desk are recorded 
automatically as you play audio from the EDL. All changes to the 
position of faders and pan pots are recorded.
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With automation on, whenever you play the EDL, mixing moves 
recorded are played back automatically.

 

Undo Pass/Redo Pass

 

Each time that you make changes in the mixing moves recorded in a 
Session, a new automation “pass” is created. Using the Undo Pass and 
Redo Pass commands, you can revert to a previous version of your mix 
Session to add to or change the moves up to that point.

 

End Pass

 

If you have created multiple automation passes, and used the 
Undo/Redo commands to move back in the sequence of passes, you can 
use this command to jump forward to the very last pass created.

 

Take SnapShot

 

The Sonic mixing automation stores mix info in two forms. Dynamic 
automation moves are recorded during playback, by moving the Mixing 
Desk faders and pots.

Snapshots may be recorded while the system is stopped or on the fly 
during playback. A snapshot records the position of all faders, mutes, 
and pan pots as a single memory. When playing back, at the point that a 
SnapShot is located all the controls will jump to the positions stored in 
the SnapShot

To record a mix SnapShot at a particular location:

 

1. Play the EDL to the point where you wish to insert the SnapShot.

 

The time that appears in the Transport Panel’s window is the time at 
which the SnapShot will be placed.

 

2. Set the Desk faders, mutes, and pan pots exactly as you want them 
to appear.

3. Select the command Take SnapShot from the menu.

 

If there is already a SnapShot at the position selected, that SnapShot is 
replaced by the new one.
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SnapShots may also be placed on-the-fly by selecting Take SnapShot 
from the menu while the EDL is playing.

 

Delete SnapShot

 

If you cue to the location at which a SnapShot appears, you can remove 
that SnapShot by using this command.

 

Go To Next/Previous SnapShot

 

Go To Next SnapShot will bring you from the current play head 
(Transport Panel) position to the position of the next SnapShot in the 
Session. Likewise, Go To Previous SnapShot will move you back from 
the current position to that of the preceding SnapShot.

By using the Go To Next and Go To Previous SnapShot commands 
together with Take SnapShot and Delete SnapShot, you can easily locate 
and replace or modify any automation SnapShot 

 

The EDL

 

An edit decision list, or EDL, is created when you select New Edit List 
from the File menu. This window shows you a number of editing 

 

panels,

 

 
each of which represents a single track or channel.
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You can record sound directly into an EDL panel, or open previously 
recorded sound and cue files. You can then edit and reassemble these 
sound sections to create your finished product using a variety of editing 
tools and commands. You can shift the view in the edit panels, select 
waveform, text, or bar display modes, resize and regroup panels as 
required.

 

The Edit Panel

 

The edit panel, analogous to a 

 

track

 

 of tape, is the basic element of 
editing on SonicStudio. You can move audio within a panel, from one 
panel to another, modify all fade-ins, outs, and cross-fades, adjust level 
of any individual segment, and so on.



SonicStudio Version 5.2 1-21

Window Reference

 

The panel shown here is in the waveform display mode, with audio 
edits (fades) shown as thin vertical pink lines. The left and right Gates 
that you use to set locations for play, edit marks and so on, are shown as 
vertical black lines with a small arrow pointing left or right. You can 
grab these Gates with the mouse and slide them freely in the panel.

The In and Out edit points, used to mark sections for Insert and Delete 
commands, are shown as heavy black brackets pointing right and left. 
General-purpose editing marks such as Track Start marks appear as 
small number flags above the waveform, while the lower edge of the 
panel shows time scale and displays of the exact current time for the 
left/right Gates and edit points.

The left-hand side of the window includes fields for panel number, sync 
group (which uses an alphabetical designation), edit group (source, 
destination, or none), and an audition group that controls routing of 
panel output to the Desk. Also, there is a panel label field and small 
indicators that show when In and Out points are present off-screen.

 

Recording into an Edit Panel

 

To record directly in an EDL panel or group: 

 

1. Use the input selector and channel arming control at the lower-right 
of the left-side control group.

2. Click-hold on the input selector, at the far lower right of the group, 
to bring up a menu of available line inputs and mix-out inputs. 

 

How many you see depends on system configuration. 

 

3. Select the line input (L1, L2, etc.) from which you wish to record. 
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4. Assign line ins to all the panels you want to record to.

 

The channel-arming control appears when you select a channel input. 

 

5. To arm the channels you want to record to, click once on the control 
in each panel. 

 

Now you are ready to record.

 

6. Cue your audio source, tap the space bar, then press the slash key to 
punch into record. 

 

You will see the record control change to a red color. 

 

7. Let the recording run as long as desired, then tap the space bar 
again to halt recording.

 

When recording finishes, you will see the new audio appear in the panel, 
ready for editing. You can playback from the panel by tapping the space-
bar. This starts playback from the position of the left Gate. You may also 
use the Transport Panel’s Play button or any of the numerous options in 
the Play menu.

 

Punching In on Existing Sound

 

You can also punch in to a panel containing previously recorded sound, 
either manually or automatically, using the same procedure. 

 

1. Select your input.

2. Arm the channels.

3. Press the space-bar to start playback.

4. Press the slash key at the point you wish to punch in.

5. Press the slash key again to punch out of record without halting 
playback.
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6. Press the space bar to finish. 

 

When you press the space-bar, the system finishes up the recording 
and the new sound section appears at the proper spot.

To automate the punch in process, place In and Out edit points in the 
panel or group of panels to which you are recording, then arm and 
punch in with the slash key before the play head reaches the In point.

When it reaches the position of the In point, the panel will drop into 
record and continue up to the point of the Out point. Following the Out 
point, hit the space-bar to stop playback and finish up the recording

 

Capture Recording

 

You can use the mix or monitor output (M1, M2, etc.) selections to re-
record the contents of an edit panel into a new soundfile. This is a 
powerful way to simplify complex editing, and to apply individual 
filtering and dynamic level changes to audio segments.

To capture the contents of an edit panel or group, all you need do is set 
the panel’s input select to one of the mix out options, and begin punch 
recording as before. The output of the present panel plays back through 
the Desk where you can apply any desired filtering or dynamic mix 
changes.
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At the same time, the output of the Desk is being recorded into a new 
soundfile. When you terminate recording with the space-bar, the new, 
continuous, soundfile replaces the previous contents, with all fades, 
gain, and EQ changes in place.

 

Opening Previously Recorded Sound into the Edit List

 

To open soundfiles that you have previously recorded into an EDL 
panel, you can use the Open button in Sonic Manager or the Open 
Sound File command in the File menu. You can also open sound into an 
EDL by “mounting” another EDL, or by opening or placing a Cue file 
from the Cues library.

 

Opening Soundfiles from the Sonic Manager

 

To open soundfiles from the Sonic Manager Sounds library:

 

1. Select one or more sounds from the listing 

 

You can select multiple sounds by holding down the Shift key as you 
click with the mouse. You can also press 

 

 

 

Command-A to select all 
sounds.

 

2. Click on the Open button, double-click a single selection, or press 
the Return key.

 

The selected sound(s) will open in the EDL as defined by the selections 
in the EDL Preferences dialog. By default, sounds are opened into the 
Source edit group panels.

 

Opening Soundfiles from the File Menu

 

To open soundfiles from the menu command:
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1. Select the command Open Sound File from the Open submenu of 
the File menu.

 

The system will scan the mounted sound disk drives and display a 
dialog listing all available soundfiles.

 

2. Select the file you wish to open and press the Return key on the 
keyboard or click the OK button in the dialog.

 

As with opening soundfiles from the Sonic Manager, sounds are opened 
according to preferences selected in the EDL Preferences dialog, General 
section.

 

Mounting an EDL

 

You can also open sound into an EDL by 

 

mounting

 

 another EDL. All of 
the assembled sound segments will appear in the new EDL with all edit, 
fade, and gain relationships intact.

To mount an EDL into another EDL:

 

1. Select the command Mount Edit List from the Open submenu of 
the File menu.

 

A file select dialog will appear, listing all EDLs available on the 
system.

 

2. Select the EDL you wish to mount and close the dialog.

 

The audio contents of the selected EDL will open into the on-screen 
EDL. In the default setting, the selected EDL’s top panels will appear in 
the on-screen EDL’s Source panels. The remaining panels of the selected 
EDL will appear in order downward from the top.

For example, an EDL consists of 5 panels of audio. It is mounted onto a 
new EDL in which panel 3 is set to source. In this new EDL, panels 3-7 
will now contain the first EDL’s panels 1-5, in their original order.

If you would like the mounted EDL’s audio to appear in either 
Destination or empty panels, you can change the default with the Open 
Sound File pop-up menu of the Edit List Preferences “General” section.
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Opening Cues from the Sonic Manager

 

Cues are not complete soundfiles, but individual segments of sound 
taken from a longer file. Cues are created from selected segments in an 
EDL by using the command Create Cue Files from the EDL menu.

To create Cue files from selected segments:

 

1. Invoke the Create Cue Files command from the EDL menu.

2. To display the new files, open the Sonic Manager Cues library and 
click on the Scan button.

 

All selected segments in the currently selected panel(s) of the EDL are 
converted into Cue files that have the same name (see discussion of 
segment names and editing in the text view display). The Cue files you 
create will appear in the Sonic Manager Cue library, following a “scan.”

Cues may be placed into an EDL from the Cues library of the Sonic 
Manager in one of two ways. You can select a Cue and click the Open 
button, or you can drag the desired Cue to the target EDL using the 
mouse.

When you use the Sonic Manager Open button, the cue is placed in the 
currently selected panel. 

If there are two or more channels in the cue, the additional channels 
appear in sequential panels, starting from the selected panel at the cue’s 
“time stamp” position.

The time stamp of a cue is the position in time occupied by the source 
segment from which the cue was made, at the time that the cue was 
created.

 

Drag-and-Drop of Cues from the Sonic Manager

 

You may also place Cues into an EDL by using the mouse to “drag-and-
drop” them directly from the Sonic Manager’s Cues library.

To place Cues from the Sonic Manager using drag-and drop:
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1. Position the Sonic Manager window and the EDL window on-
screen such that you can see both windows.

2. Select the Cue file you wish to place from the Sonic Manager Cues 
library.

3. Drag with the mouse, holding down the mouse button as you do, 
from the Sonic Manager window to the panel in which you want to 
place the selected Cue.

 

As you drag into the EDL, the target panel is highlighted. When you 
release the mouse button, the selected cue drops into position.

The position in time at which the Cue file appears is determined by the 
Cue Placement command in the EDL menu. This command opens a 
small dialog to select one of four available modes.

 

•

 

Place according to mouse position at time the button is released.

 

•

 

Place according to the position of the edit In and/or Out points.

 

•

 

Place according to the play head (Transport Panel) time.

 

•

 

Place according to the time stamp of the cue.

The four modes are represented by icons in the Cue Placement select 
dialog. As you point at each icon with the mouse, the name of the mode 
it selects is listed at the bottom of the dialog.

When you select a mode, that mode remains in effect until you select 
another mode from the Place dialog.

 

Changing the View in an Edit Panel

 

You can change the view in a given edit panel by moving or zooming to 
different areas and levels or magnification, or by changing the display 
mode for the panel.
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Use the command Display Panel As... in the EDL menu to change the 
display mode of the selected panel or panels. The three principle display 
modes used for editing are waveform, bar, and text. The text display is 
particularly useful in displaying edit information in precise numeric 
form, as compared to the waveform and bar displays’ visually oriented 
representations.

 

Using the Control Bar

 

The strip along the top of the EDL includes displays and selectors useful 
in editing.

Use the four buttons at the left of the bar to select an edit tool for use 
within the panel. When you select a tool, the selection is held until you 
change it. You can also select edit tools using keyboard equivalents: G 
for Gates, R for Reel-Rock, F for Fade, and T for Segment.

The 

 

Gate

 

 tool is the initial default selection. With this, you can place left 
and right Gates anywhere in a panel, to define edit marks and so on.
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Use the 

 

Reel-Rock

 

 tool to precisely locate an audio feature by slow play. 
This works best when you are zoomed in close to the waveform display.

With the 

 

Fade

 

 tool, select the fade of any audio edit on-screen and 
extend or move it as desired. For greater control, use the Edit Fade 
window.

Use the 

 

Segment

 

 tool to select and drag individual segments of audio 
within a panel or between different panels. Hold down the option key 
while dragging to duplicate a segment. Hold down the shift key to force 
placement of a segment into the same time position in another panel. 
Shift and option can be used simultaneously.

The time display fields show the current position of the left and right 
Gates, and of the In and Out edit points when present. The center field 
shows the current duration between the positions of the Gates or of the 
edit points. Select the mode of display using the central toggle button.

 

Editing Sound in the EDL

 

Once you have sound in the EDL display, there are numerous ways in 
which it can be manipulated.

There are four principle ways to move sound within an EDL:

 

•

 

The Insert and Delete commands in the Edit menu.

 

•

 

Dragging of segments using the Segment tool

 

•

 

Cut-and-Paste of audio segments.

 

•

 

Changing the start time of a segment in the Text view display.

 

Using the Insert and Delete commands

 

The Insert and Delete commands are the computer equivalents of cutting 
and splicing tape.
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The Insert and Delete commands each have several variations, which 
may be divided into Basic or Ripple versions of the core command 
(Insert or Delete).

The selection of (basic) Insert or Insert & Ripple determines what 
happens to the audio that follows the edit. Variant commands within 
these two types determine which of a selection of default settings are 
used for the fades at the Edit Points. Default fades are discussed in the 
section on the Edit Fade dialog.

When Insert is used, a section taken from the Source panels replaces the 
audio that existed previously in that section and the timing of all audio 
following the edit is preserved. Similarly, the Delete command does not 
effect the audio outside the edit. When the Insert & Ripple variant is 
selected, audio following the edit moves to accommodate the edit.

Basic

Insert and
Ripple
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For basic Insert, there are two Edit Points (In and Out) in the Source 
panel(s), but only one (the In point) in the Destination. For this reason, 
Insert is known as a “3-point” edit. The length of the audio section 
replaced in the Destination panel is determined entirely by the length of 
the section between the In and Out points in the Source panels. If some 
of the Edit Points required for an Insert or Delete command are not 
placed in the Source and Destination panels, the system assumes that 
these points are “implicit,” following a set of clear rules.

 

•

 

If a needed In point is missing from a Source panel, the beginning of 
the track is used as the In point instead.

 

•

 

If the Out point is missing from a Source panel, the end of the track is 
used.

 

Insert and Delete with Ripple

 

When an Insert & Ripple command is executed, audio following the edit 
is displaced to the right of the display (later in time), changing the total 
length of the target panel. Insert & Ripple may be executed as either a 3-
point or a 4-point edit (In and Out points present in both Source and 
Destination).

In the 4-point variation, the audio between the Edit Points in the 
Destination panels is replaced by the audio from the Source panel(s). 
Audio that comes after the Out point is slid left or right when the edit is 
executed.
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With Insert or Delete with Ripple, the total length of the track 

 

always

 

 
changes, except in the unlikely case that a section is replaced by a chunk 
of audio of exactly the same length. With the basic command, overall 
length is affected only if the Insert or Delete comes at the very end of the 
track. If both In and Out points are present in the Destination panel(s), 
the Insert & Ripple command replaces the material between the Edit 
Points.
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As with Insert, the Delete commands have sub-variations that select 
default settings for the fade(s) created by the edit. The Delete command 
removes a designated section from the target panel. The deleted section 
is replaced by perfect (digital) silence.

The Delete & Ripple commands delete audio and then “close” the gap 
between In and Out points.

 

Dragging Audio Segments

 

Dragging is the quickest and most intuitive way to move a segment or 
group of selected segments. It is not, however, the most precise. You will 
probably find that dragging will be useful for basic construction of a 
track, and other methods best for “fine tuning.”

 

Basic Delete

Delete and Ripple
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When a segment is dragged (Option click-drag) within a panel, a 
“ghost” image of it is visible. When the mouse button is released, the 
segment drops into its new position:

To move a segment to a new position in the panel using the Segment 
tool:

 

1. Select the Segment tool by clicking on the icon for it in the tool bar 
at top of the EDL, or by pressing the letter T on the keyboard.

2. Select the segment or segments to be moved.

3. Holding the mouse button down, drag the mouse to the left or right 
to move the segment(s) within the same panel, or up or down to 
move it to a different panel.

 

An outline of the selected segment(s) will be seen to move on the 
screen, along with the cursor.

 

4. When the cursor is at the desired position, release the mouse 
button.

 

The selected segment or segments appear(s) in the new location.

 

Cut-and-Paste Editing

 

Macintosh-style Cut, Copy and Paste commands can be used to move 
segments between panels.

Selected segments are cut or copied from one panel and pasted into 
another at a location depending on whether or not any segments are 
selected in the target panel and whether there is an In point.
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To Cut or Copy audio from a panel:

 

1. Select the segment or group of segments to be Cut or Copied.

2. Select Cut or Copy from the Edit menu, or use the key equivalent.

 

The key equivalents for the commands are the same as for general 
Macintosh applications:  Command-C for Copy,  Command-V for Paste, 
and  Command-X for Cut.

 

Editing in the Text View Display

 

Whether edits are produced by defining and moving segments or by the 
Insert and Delete commands, the resulting Edit List can be viewed and 
edited in a textual, as well as a waveform, format.

To switch any selected panel from Waveform to Text format and back:

 

•

 

Use the key combination  Command-T to switch a panel from 
Waveform to Text format.

 

•

 

To switch from Text back to Waveform, use  Command-Y.

Any panel of an Edit List can be switched from Waveform display to 
Text and back freely.
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Each audio segment is represented by one line of the text display, with 
eight columns that describe the segment.

All of the fields may be changed by the user, except “Segment Length” 
which is calculated based on the In and Out points.

 

Segment Times and Edit Times

 

The time fields in the Text display can show the Start, End, and Length 
parameters in three different ways. The user changes the mode of time 
display by clicking on the field at the top of the Start column

 

Start-seg

 

 - The Segment Start time is the exact time in the Edit List at 
which audio begins to fade up at the beginning of the segments. 
Likewise, the End time is the moment of the last audio sample that is 
heard.

 

Start-ed

 

 -

 

 

 

The Edit Start is the point at which the In or Out point is 
placed in relation to the fade-in. When editing with Insert and Delete, 
the editing 

 

cuts

 

 are placed exactly at the Edit Points, with the fade-
in/outs overlapping these points to form a cross-fade.

Segment 
Name

Track
Number

Start 
Time

End
Time

Segment
Length

Gain

Seg
Lock

Edit Fade

 

Segment
Name

Track
Number

Start
Time

End
Time

Segment
Length

Gain Seg.
Lock

Edit
Fade
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Naming Segments

 

Initially, each segment is given the name of the soundfile from which it is 
taken. The user has the option of renaming segments to describe their 
contents.

To change the name of a segment:

 

1. Click the line that represents the segment of interest.

2. Double-click the Segment Name field or press the Enter key. 

 

This brings up a dialog to change the value. Other fields of the Text 
display work in similar fashion.

 

Moving Segments

 

Segments may be moved from one track to another, or they can be 
moved within the same panel, simply by editing the parameters in the 
Text display.

 

Panel Number

 

All segments in a panel have the same Panel Number, by definition. A 
segment may be moved (cut) from one panel to another simply by 
changing the Panel Number.
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To move a segment from one panel to another:

 

1. Click on the line that represents the segment of interest.

2. Double-click (or press the Enter key) on the Panel Number column 
to change its value.

 

This brings up a dialog to change the value. The user enters a new 
time value, then closes the window to perform the edit.

An error is generated if moving the segment to the new location would 
cause simultaneous overlap of three segments.

 

Start Time

 

In the Text display, segments may be moved within the same panel by 
changing the value of the Start Time parameter. The length of a segment 
may be changed as well, by 

 

locking

 

 the segment and changing either the 
Start or End Time.

As with other columns of the Text display, the Start Time of a segment is 
edited by double-clicking to call up a parameter-entry dialog. In this 
case, the dialog shows a time value, rather than text or straight numeric 
entry.

The effect of changing the Start Time depends on whether the segment is 
“locked” or not. (The status of each segment is set from the column at 
the right-hand side of the Test display.)

If the segment is not locked (the default condition), then changing the 
Start Time moves the segment as a whole, just as when dragging the 
segment in the Waveform display.

If the segment is locked, then the end of the segment remains in its 
original position, and changing the Start Time changes the length of the 
segment. In this way, a segment can be made smaller or larger, up to the 
length of the original file.

To change the Start Time of a segment:

 

1. Click the line that represents the segment of interest.
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2. Double-click the Start column.

3. Enter a new time. 

 

The Start, End, and Length times use standard SonicStudio time value 
entry formats. The display format is taken from the EDL Preferences.

Times may be entered individually, or they may be copied from other 
time fields in the system.

 

End Time

 

The End Time for a segment behaves in the same manner as the Start 
Time. If the segment is not “locked,” then changing the End Time moves 
the entire segment. If the segment is locked, then the segment remains in 
place, but its length changes.

 

Segment Length

 

The Segment Length is not changed directly by the user. It is calculated 
from the Start and End Times. The length can be changed by “locking” 
the segment and altering either the Start or the End Time.

 

Changing Gain

 

Double-clicking the Gain field brings up the Gain Adjust dialog, exactly 
as when the Gain Adjust command is used in the Waveform display.

To Set the Gain that applies to a segment:

 

1. Option-double-click the Gain parameter field of the segment of 
interest.

2. Set the gain desired in the Gain Adjust dialog and click OK.

 

Locking Segments

 

A selected segment can be 

 

locked

 

 with Lock Selected Segments in the 
Select Segments Submenu of the Edit Menu or by double-clicking on 
lock in Text Display. When the segment is unlocked (N), then changing 
the Start or End Time moves the segment as a whole without changing 
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its length. If the segment is locked (Y), the sound remains in the same 
place but is shortened or lengthened by the amount which the start time 
is changed.

Note – A locked segment cannot be edited. Any attempt to alter a 
segment with insert or delete edits, dragging or gain changes will bring 
up an alert. This includes Insert, Insert & Ripple, Delete, and Delete & 
Ripple performed in an area ahead of the locked segment if the rippling 
might affect its position.

Editing Segment Fades from the Text-Format Display

Double-clicking the fade column opens the Edit Fade window, described 
in detail in The Edit Fade Window below.

To open the Edit Fade window from the Text display:

1. Select the Start or End time. 

2. Choose Edit Gated Fade from the Edit menu. 
Edit Fade will open on the Fade In or the Fade Out of the selected 
segment.

Option-double-click on the mark in the last column of the Text display to 
bring up the Fade Out of the selected segment.

To bring up the cross-fade between the two segments:

1. Select two adjacent segments with Option-Shift-drag.

2. Option-double-click the cross-fade field of the first segment of the 
pair. 
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Overlapping Segments

 

If a segment overlaps another segment, both segments play normally, 
but the system will give an error and refuse to perform an edit that 
results in three or more segments sounding at the same time on a single 
panel. In this case, the “track” parameter of the list is useful, because the 
offending segment can be simply moved to another track.

 

Using The Fade Tool

 

The Fade tool in the Tool Bar is the fastest and simplest method of 
editing fades. With this tool, the user can select the pink line 
representing an In, Out, or cross-fade and alter its duration or move the 
edit itself by dragging with the mouse. In many cases, using the Fade 
tool eliminates the need to open the Edit Fade window. Adjustments to a 
fade in one track affect the corresponding fades in all tracks in the Edit 
Group.

To adjust the length of a Fade In or Fade Out using the Fade tool:

 

1. Click on the Fade tool in the Tool Bar.

 

The cursor will change to a pair of arrows going left and right from a 
diagonal line.

 

2. Click on the fade you wish to adjust.

 

Small grab boxes will appear at its lower left and upper right corners. 
These are reversed for a fade-out.

Selected
Fade

"Grab" boxes
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3. Click on one of the grab boxes, hold the mouse button down, and 
drag until the fade is the desired length.

 

Dragging the box on the lower-left of a Fade In extends the fade 
ahead of the current position, revealing additional audio (if audio is 
present in that portion of the source file). 

Dragging the box on the upper-right of a Fade In extends the fade 
after the current position, making the end of the fade later in the 
segment.

These effects are reversed for Fade Outs.

 

4. Release the mouse button.

 

To move the position of a fade:

 

1. Click on the Fade tool in the Tool Bar

 

The cursor will change to a pair of arrows going left and right from a 
diagonal line.

 

2. Click on the fade you wish to move.

 

The grab boxes will appear, confirming that the fade is selected.

 

3. C lick in the middle of the fade, hold the mouse button down, and 
drag the fade to the desired location.

4. Release the mouse button.

 

Moving a fade in this fashion will shorten or extend (with additional 
audio from the source soundfile) the audio segment.

 

The Edit Fade Window

 

All parameters of Fades In, Fades Out, and each side of a Cross-fade can 
be separately adjusted over a broad range: the length of the fade, the 
shape of its curve, and the relationship of the start and end of the fade to 
the Edit point.
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To access the Edit Fade window from the Waveform Display:

 

1. Place the Left and Right Gates to either side of the fade to be 
edited.

2. Pull-down the Edit menu and select Edit Fade.

 

The Edit Fade window opens showing either one or two waveform 
panels, depending on whether the selected fade is a cross-fade or a 
single fade up or fade down.

The Edit Fade window is a comprehensive environment for modifying 
the way that an edit crosses from one side to the other, as well as the 
exact positioning of the Edit Points and audio on either side of the edit.
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With this window, it is possible to tailor an edit in nearly any way 
imaginable. The Edit Fade Window is best understood by dividing its 
functions into different sections.

This window can affect three (and only three) aspects of an edit:

 

•

 

The duration and shape of the fade-out of material ahead of the edit, 
and the fade-in of new material following the splice.

 

•

 

The time relationship between the start and stop of each fade.

 

•

 

The placement of sound on either side of the edit.

 

Waveform Panels

 

The waveform panels in the Edit Fade window behave much like panels 
in the editing display.
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The Left and Right Gates are fully active in these panels, as is the 
Transport Panel. All Move and Zoom commands can be used.

The Adjust Gain command from the Edit menu is also available. It 
affects whichever side of the fade is selected with the Fade-In and Fade-
Out check boxes. If both sides are selected, the gain change applies to 
both segments.

Edit Points (In and Out) can be placed in the Edit Fade window’s 
waveform panels, following some special rules. The general-purpose 
editing marks are not available.

The Out point can be placed in the upper panel 

 

only, 

 

while the In point 
is only available in the lower panel. (Remember that these two panels 
represent the two sides of an edit in the same panel on the regular edit 
display).

Note that the sound in the upper panel 

 

never

 

 moves when the position 
of the Edit Points changes. The audio in the lower panel 

 

may

 

 move if the 
Lock Sound in Place box is not checked (see below).

 

Audition and Control

 

The Audition & Control section of the Edit Fade Window determines 
whether one or both sides of the fade are affected by changes in the fade 
parameters or placement of the Edit Points. It also controls how sound in 
the lower (fade-in) panel moves in response to changes in the position of 
the Edit Points.
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Audition button

 

The Audition button is used to hear the actual edit and fade, as modified 
in the Edit Fade window. Playback is affected by the state of the Fade In, 
Fade Out, and Audition Both check boxes (described below) and the 
preferences set in the Audition section of the EDL Preferences dialog.

The Play menu commands can be used to listen to the selected panel 
without regard for the displayed fades. For example, the command Play 
To Gates will play the sound between the Gates regardless of where the 
fade is placed. The Reel Rock feature can be used to shuttle, jog or scrub 
the audio in the waveform panels.

 

Audition Both, Fade-Out and Fade-In

 

These check boxes appear when editing a cross-fade. The Fade-Out and 
Fade-In boxes select which sides of the fade will be affected by any 
parameter changes.

The Fade-Out/Fade-In check boxes also affect the operation of the 
Audition button. When both boxes are checked (the initial default), 
Audition plays both sides of the fade. The user hears the edit as it will 
sound in the final product.

If only one box is checked, the Audition button plays only that side of 
the fade. By checking on the Fade-Out box, the user can hear the lead-in 
to the edit, complete with fade-out. If Fade-In is checked, the user can 
hear how the audio fades up on the other side of the edit.

The Audition Both check box overrides the individual check boxes, so 
that the user can hear the complete edit while adjusting one side or the 
other.
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Edit Point Offset

 

In the Edit Fade window, the user can change the locations of the In and 
Out points of an edit in relation to one another. The amount of time 
between the two points is the Edit Point Offset.

When an edit is first created, the In and Out points are both located at 
the same point in time, so that the Edit Point Offset is zero 
(00:00:00:00.00).

If either of the Edit Points is moved (by nudging, etc.) or placed in one of 
the panels in the Edit Fade window, an offset is created.

In the Edit Fade Window, there are three ways to change the position of 
an Edit Point:

 

•

 

Use the Set In/Out point menu selection under the Mark menu.

 

•

 

Option-click on the Edit Point and directly change the value.

 

•

 

Use the Nudge section of the window, described below.

 

Lock Sound In Place

 

The state of this check box determines how the audio following an edit is 
affected when one or both of the Edit Points are moved or nudged. Lock 
Sound In Place can be deselected only when nudging both sides of the 
fade. It is automatically switched on when either side of the edit is 
nudged singly.

With Lock Sound In Place turned 

 

off,

 

 the edit remains fixed at the same 
place in the panel. The sound to the right of the edit slides in relation to 
the edit, so that less or more of the original source soundfile is heard. 
With Lock Sound In Place switched 

 

on,

 

 the edit itself moves. The sounds 
on either side of the edit remain fixed.

 

Ripple Until Black 

 

Ripple Until Black affects audio which follows the fade being edited. 
Normally, any change causing the right half of a fade to be shifted in 
time causes all subsequent edits to be rippled by the same amount. 
When Ripple Until Black is checked, edits to the right of the fade shown 
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in the Edit Fade dialog are rippled, but only until a section of “digital 
black” (silence) is encountered. The Edit Fade Preferences dialog (in the 
Preferences submenu of the File Menu) allows the user to set the default 
for this function.

 

Nudge Edit Arrows

 

The Nudge Section of the Edit Fade window operates in a manner 
similar to that of the Nudge Right and Nudge Left commands in the 
Mark menu, moving one or both Edit Points.

Three radio buttons select the amount of motion. The Fade-Out and 
Fade-In check boxes described earlier determine which of the Edit Points 
will be affected. Note that the Lock Sound In Place check box also plays 
a critical role in determining the effect of nudging. If the Audition check 
box in this section is selected, an audition will be triggered immediately 
following each nudge. The Auto Zoom check box affects nudging 
operations and adjustments to the fade parameters. With this box 
checked, the waveform panels will automatically move to keep the fade 
in view. If the duration of the fade is set so that the fade no longer fits in 
the window, the panel will zoom to enclose the new fade.

 

Fade Parameters and Templates 

 

SonicStudio provides extensive control over cross-fades. The exact 
duration, shape, and positioning of each side of a cross-fade can be 
controlled with ease and precision.

The same control applies to single fades where the audio fades to or 
from silence (digital black). When a single fade is selected, the Edit Fade 
window opens with only a single waveform panel visible.
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Fade-Out and Fade-In are described above. Besides affecting the 
movement of the Edit Points, the state of these check boxes determines 
whether the Fade Parameter sliders affect both halves of a fade, or only 
one side or the other.

 

Fade Envelope Type

 

Each side of the fade uses a distinctive curve type. This fade 

 

envelope

 

 
may be adjusted for length, overlap, etc.

Clicking on either of the Envelope boxes brings up a pop-up menu to 
select from a family of curves that may be used for the fade.

The three basic fade types are Linear, Cosine, and Exponential. The 
illustration below shows fade-ins. 

The Cosine and Linear curves are modified by the dB Down parameter 
(described below), while the Exponential curve can be modified by the 
Alpha parameter slider as well as the Power Lock check box. The 
remaining selections in the Envelope pop-up menu are variations of the 
basic curves derived by changing these parameters.

Linear Cosine
Exponential 

(Power Lock ON)



1-50 SonicStudio Version 5.2

 

Reference Manual

 

The Root versions of Cosine and Linear are identical with the standard 
version, but with the dB down (see below) set to a value of 3.0. The 
Alpha-Exponential envelope is the standard exponential fade envelope 
with the Alpha value set to 1.0.

 

Duration parameter

 

Duration is expressed in seconds, with a range from 2.9 milliseconds 
(0.0029 seconds) to just over 100 seconds. As with other fade parameters, 
the duration of each side of a cross-fade may be changed separately. 
SonicStudio performs all fades by controlling gain during playback. 
Long cross-fades do not require additional audio memory or 
computation time.

 

Overlap parameter

 

In the default setting, fades are placed so that the corresponding Edit 
Point is exactly half-way through the fade, for an Overlap factor of 50%. 
As the Overlap is adjusted, the fade slides left or right while the Edit 
Point remains fixed. The fades move in opposite directions unless 
“Align” is selected. In that case, the fades move in the same direction.

At 0% Overlap, the end of the fade falls at the exact position of the Out 
point. 100% Overlap puts the 

 

beginning

 

 of the fade at the Edit Point. For 
the fade-in, these relationships are reversed, so that the fade 

 

ends

 

 at the 
In point when the Overlap is set to 100%, and begins at that point when 
the Overlap is set to zero.

(with Power-Lock OFF)Root-Cosine Root-Linear
Alpha-Exponential

0% Overlap 50% Overlap 100% Overlap
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db down parameter

 

The dB down parameter affects 

 

only

 

 the Cosine and Linear fades. It sets 
an “anchor point” at the position of the Edit Point. The remainder of the 
curve is drawn in relation to this “fixed” point:

The Cosine fade follows the same rules:

Because the point established by the dB down parameter is placed 
relative to the Edit Points, the shape of the curve is affected by the 
Overlap parameter as well.

 

Alpha parameter

 

The Alpha parameter affects 

 

only 

 

the Exponential curve. It controls the 
placement, in time, of the gain change produced by the exponential 
envelope. Alpha is a dimensionless parameter, whose range is -1 to +1.

6 dB down 12 dB down3 dB down

Linear Crossfade (50% Overlap)

6 dB down 12 dB down3 dB down

Cosine Crossfade (50% Overlap)

Alpha = 0 Alpha = +1.0Alpha = -1.0

Exponential Crossfade (Power Lock OFF)
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The straight Exponential cross-fade tends to produce either a large bump 
or drop in perceived level at the mid-point of the fade. The Power Lock 
check box can be used to produce, in effect, another type of curve.

 

Power Lock 

 

Power Lock affects 

 

only

 

 cross-fades of the Exponential fade type. When 
Power Lock is selected, the two curves are drawn so that one curve 
perfectly complements the other. The sum of the gains on either side of 
the fade equals unity.

 

Fade Templates

 

Complete sets of fade parameters may be stored as Fade Templates. 
There are four permanent templates, and you can add and delete your 
own templates as needed.

The Templates are stored and recalled using the buttons in the lower 
right-hand corner of the Edit Fade window.

To store an edited fade as a Fade Template:

 

1. Click-hold with the mouse on the Write button.

 

A dialog box appears prompting the user to enter a name. The name 
of the current fade, whether default or previously stored, is displayed 
in the edit box.

Alpha = 0 Alpha = +1.0Alpha = -1.0

Exponential Crossfade (Power Lock ON)
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2. To overwrite the current Fade Template, click OK.

 

A Warning dialog confirms the user’s intention to overwrite the 
previous Fade Template. If the user answers “Yes” to this warning, 
the new Template is written, and the previous Template of that name 
permanently erased.

 

3. To create a new Fade Template, type in the new name, then click 
OK.

 

The new Fade Template is added to the list that appears when the 
Fade Template button is used to recall a Fade Template.

To recall a default or previously stored Fade Template:

 

1. Click-hold with the mouse on the Fade Template button.

 

A pop-up menu lists the available Fade Templates.

 

2. Select the Fade Template to open.

 

The three kinds of Fade Templates are fade-in, fade-out, and cross-fade. 
Only Templates of the same kind as the current Template are shown as 
active.

SonicStudio has four default settings for fades. Two of these are cross-
fades: Out Cross Fade and In Cross Fade. One default, Fade From Black, 
is a fade-in type, while Fade To Black is the default fade out.

You can alter the default settings, but not delete them. When an Insert or 
Delete command is executed, it uses one or more of the default fades.
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As additional Fade Templates are stored, their names are added to the 
Fade Template menu.

To delete a stored Fade Template:

 

1. Click-hold on the Delete button.

2. Select the Template to delete from the pop-up menu.

 

Next and Previous buttons

 

These two buttons move the Edit Fade window to the next or previous 
edit in the panel. In this way, you can move through all of the edits 
without leaving the Edit Fade window.

 

The Listing Window

 

The EDL Listing, accessed from the Format EDL command of the EDL 
menu, provides a frame accurate edit list based on the editing choices in 
a particular EDL. This listing is a text file that can be printed or saved.
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To open an EDL listing window, select the command Format EDL from 
the EDL menu. This converts the information in the current EDL into 
textual form and formats into a standard listing.

 

The Transport Panel

 

The Transport Panel allows precise control of playback, editing and 
machine control functions.

The Transport Panel is divided into functional areas. The lower right-
hand portion provides a set of tape-style transport controls including 
play, stop, record, and pause.
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Above the transport control is a time display that shows the current play 
locations. Underneath that is a set of buttons and pop-up menus to 
indicate current time display mode. The + and - buttons provide for 
nudging of external transports. The strip underneath these buttons is 
used to scrub, or reel-rock, audio.

The group of Cue fields to the left of the time display is used to locate 
EDL and external transports. You can type in arbitrary time values, or 
grab the current play time by selecting the entire field then hitting the 
space bar. When you click on one of the Cue buttons to the left, the play 
location jumps to the new value.

SonicStudio can slave its playback to incoming time code, and with the 
SS-516 Machine Control option, it can operate with external transports as 
master or slave. The buttons in the lower left portion of the Transport 
Panel are used to define master and slave for synchronization.

 

The Sonic Manager

 

The Sonic Manager is sound, cue and video files for editing and 
playback. It allows the user to quickly find and open EDLs, Projects and 
Sessions. The Sonic Manager also provides tools for maintaining and 
organizing both these materials and the system’s Sound Disks.
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To open the Sonic Manager, select the command Sonic Manager from the 
Managers submenu in the File menu.

 

The Sounds library

 

When the Sonic Manager opens, it displays a list of soundfiles in 
alphabetical order. Stereo and multi-channel soundfiles are shown as 
folders that contain the individual channel recordings. Size (in 
megabytes) and path-name are shown in columns alongside. To change 
the sort of the listing of folders by duration, or path-name, click on the 
label at the top of the column.

You can find individual soundfiles in the manager’s listing by typing the 
first few letters of the soundfile name at the keyboard. As you type, the 
window scrolls to locate and select the file you seek.

Selected soundfiles may be opened into EDLs, renamed, moved, copied 
to other disks, or deleted

 

 

 

using the top-row buttons.
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In addition, any soundfile may be played without leaving the Manager 
window. To audition a soundfile, select the desired file by mouse or by 
typing, then click on the Audition button.

The Utilities button provides access to administrative and maintenance 
functions. Among these are commands useful in recovering soundfile 
and waveform information.

 

UFID

 

 SonicStudio’s native file system is known as MOFS, or Media 
Optimized File System. MOFS uses a system of file identifiers to keep 
track of multiple copies of a file that may exist in a MediaNet network. 
MOFS also makes it possible to use third-party archive software to 
backup and restore Sonic soundfiles.

When an archive is restored from such a utility program, new file IDs are 
created which require resolution with the original ID numbers so that 
EDLs will recognize these files as belonging to them. The UFID 
(Universal File ID) command restores the original file IDs to a group of 
selected files.

 

Waveform

 

 With the Waveform button, you can reconstruct the 
waveform display data used to view a recording. Use this command in 
any case where an EDL waveform display appears corrupt or does not 
match the sound heard. The repair operation works in the background to 
rebuild the waveform display data from scratch.

Note – Reconstructing waveform display data can be a lengthy 
operation, and cannot be aborted once initiated.

Export Use the Export button to convert Sonic soundfiles into standard 
AIFF files stored on the Macintosh’s hard disk. These files can be opened 
and used by other multimedia applications.
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Each soundfile has an information dialog that lists its most important 
characteristics, such as the duration, time stamp, and sample rate of the 
file.

To open the Information dialog for a file, select that file in the library, 
then click on the small question mark box at upper left of the Manager 
window.

 

The Disks Library

 

In the Sonic Manager, each library provides facilities to administrate and 
find all files and storage devices used in system operations.
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The Disks library shows all readable storage units attached to the 
system, including Macintosh volumes. MOFS (sound disk) volumes are 
displayed with a distinctive icon. Unmounted volumes, including 
network volumes, are shown with the MOFS icon, but dimmed.

Use the Scan button in the second row to read disks that are added to the 
local system or to remote MediaNet stations. When disks are unmounted 
and taken off-line, the Scan function is also used to remove these disks’ 
icons from the displayed directory.

You can selectively take individual disk volumes off-line, or attach to 
other volumes that have been added or brought on-line over a MediaNet 
network. To mount a remote sound disk volume or unmount a volume, 
select that disk’s icon, then click on the Unmount (Mount) button.

Use the Rename button when you need to change the name assigned to 
a disk volume.

The Utilities section of the Disks library includes a Remake button. This 
button is used to create a new MOFS volume or restore the file system of 
a disk that has been in use and needs clearing of file fragments. It does 
not appear if the system is equipped with a MediaNet network card.
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The Cues Library

 

The Cues library works like the Sounds library, but instead of showing 
complete recordings, it shows sections of audio selected and named by 
the user from the soundfiles.

You can store any audio segment from an EDL as a Cue, which you can 
then open and place in any EDL, independent of the soundfile from 
which it is taken.

The Cue file itself does not contain sound, only pointers that define start 
and end times, fade, and gain/phase information. If the original 
soundfile is not available, all cues using that file also are likewise 
unavailable.

Cue files for soundfiles that have been deleted or taken off-line are not 
deleted automatically, so that they can be used if the original soundfile is 
later restored.
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Creating Cue Files

 

To create a Cue file: 

 

1. Open the desired source soundfile into an EDL. 

2. Use any of the editing functions to define the segment that you 
want to use as a Cue, including fade in/out, gain, and/or phase 
invert.

3. In the text-mode display, assign a name for the segment as you wish 
the Cue to be named.

4. Select that segment and deselect any other segments in the EDL.

5. From the EDL menu, select the command Create Cue Files.

 

You may select any number of segments to be transformed into Cues. 
When you select Create Cue Files, it creates a separate Cue file for 
each selected segment in the EDL. For this reason, you need to 
deselect segments other than those you want to save as Cues before 
invoking the command.

 

6. After creating a Cue or group of Cues, you must click on the Scan 
button in the Cue library. 

 

This updates the displayed list to show the newly created Cue files.

The Cue file saves the file’s stereo or multi-channel mates, as well as all 
editing, fade, and gain information. The file is stored with the name of 
the segment as it appeared at the time the command was invoked.

 

Opening and Placing Cue Files in an EDL

 

From the Cue library, you can place selected Cue files into an EDL by 
clicking on the Open button to insert to the selected panels of the current 
EDL, or by dragging the icon of the Cue to the desired panel.

Cues may be placed into an EDL from the Cues library of the Sonic 
Manager in one of two ways. You can select a Cue and click the Open 
button, or you can drag the desired Cue to the target EDL using the 
mouse.
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When you use the Sonic Manager Open button, the cue is placed in the 
currently selected panel.

If there are two or more channels in the cue, the additional channels 
appear in sequential panels, starting from the selected panel at the cue’s 
time stamp position.

The time stamp of a cue is the position in time occupied by the source 
segment from which the cue was made, at the time that the cue was 
created.

You may also place Cues into an EDL by using the mouse to “drag-and-
drop” them directly from the Sonic Manager’s Cues library.

To place Cues from the Sonic Manager using drag-and drop:

 

1. Position the Sonic Manager window and the EDL window on-
screen such that you can see both windows.

2. Select the Cue file you wish to place from the Sonic Manager Cues 
library.

3. Drag with the mouse, holding down the mouse button as you do, 
from the Sonic Manager window to the panel in which you want to 
place the selected Cue. 

4. Release the mouse to place the Cue.

 

As you drag into the EDL, the target panel is highlighted. When you 
release the mouse button, the selected cue drops into position.

The position in time at which the Cue file appears is determined by the 
Cue Placement command in the EDL menu. This command opens a 
small dialog to select one of four available modes.

 

•

 

Place according to mouse position at time the button is released.
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•

 

Place according to the position of the edit In and/or Out points

 

•

 

Place according to the play head (Transport Panel) time.

 

•

 

Place according to the time stamp of the cue.

The four modes are represented by icons in the Cue Placement select 
dialog. As you point at each icon with the mouse, the name of the mode 
it selects is listed at the bottom of the dialog.

When you select a mode, it remains in effect until you select another 
mode from the Place dialog.

 

Organizing and Maintaining the Cue Library

 

To view the Cues you have created: 

 

1. From the Sonic Manager and select the Cues library. 

 

The Cue appears by name on the left, with the Path (including the 
name of the source soundfile) appearing to the right.

 

2. Select one or more Cues using the mouse. 

3. Use the buttons in the second row at top of the Sonic Manager to 
audition, place (see below), delete, or rename the Cue files.
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Cue Editing

 

Because Cues are just segments taken from soundfiles, they may be 
edited in an EDL as with any other sound. Once a Cue is placed, it may 
be altered using any of SonicStudio’s editing tools. You may save as 
many versions of a Cue as you wish.

Save altered Cues using the procedure outlined in 

 

Creating Cue Files

 

 
above. Since Cues do not contain the sound itself, you may delete any 
Cue without affecting any other. However, remember that if you delete 
the source sound all Cues that use that soundfile will be not be available 

 

The EDLs, Projects, and Sessions Libraries

 

With the Sonic Manager, you can track edit lists, Project files, and Desk 
automation Sessions in the same way that you locate soundfiles.

When you select one of the library types, using the buttons along the top 
of the Manager window, the system will quickly scan all mounted disk 
volumes, both MOFS and Macintosh HFS, and locate all files of that 
type.

When you select a file in the library, buttons will then become active to 
let you open, rename or delete files. You can still open EDLs, Projects, 
and Sessions from the File menu. Files located on Macintosh volumes 
can also be renamed and removed from the Mac Finder.
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The Video Library

 

When equipped with the SonicVideo operation and video capture board, 
the Video library provides a listing of all video clips available.

 

The Project Manager 

 

Projects are the means by which you can organize the source materials, 
final output, and archives for a given job. When you select the command 
New Project from the File menu, you are first prompted for the names of 
three nested folders (Customer, Project, Title). This lets you define work 
areas for each of your clients and separate subdirectories for each of their 
jobs.

After creating a set of folders, the initial Untitled Project window 
appears. This shows the name of the Project, with optional date and 
work order (WO) number fields for your use. 

Three buttons in the lower part of the window represent the three 
principle types of logs used in the manager: Source, Archive, and 
Delivery. These logs are used to list soundfiles to be loaded into the 
system, edit lists to be transferred to final delivery medium, as well as 
edit lists and soundfiles to be stored to archive.

 

Source Log

 

The Source Log lists the material of each Project as source tapes. You add 
tapes by pressing the button at lower left and respond to the dialog that 
appears.
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The two principle types of source tapes are Wild tapes and Timed tapes. 
Wild tapes are loaded from devices that do not support control by serial 
protocol. Timed tapes are loaded under direct control of SonicStudio, 
and require no user intervention other than to initially mount the tape. 
(Requires Machine Control option SS-516.)

Within the Tape, individual soundfiles are listed. To add soundfile 
entries, double-click on the Tape name. The lower-left-hand button 
changes its displayed title from Add Tape to Add Soundfile.

The dialog for defining soundfiles includes fields that specify the start 
time and the end time (or duration) of the file. For machine-controlled 
loading, these times are used to cue the tape.

Once the Source Log has been created, use the Load button to initiate the 
process of loading the materials into the system.

 

Delivery Log

 

The Delivery Log window defines the contents of a dump to a final 
deliverable format.
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As with the Source Log, you begin by defining one or more delivery 
tapes. Besides wild and timed tape options, the Delivery Log tape info 
dialog includes options for delivery to recordable CD. Master tapes may 
be delivered in reference form, or in pre-master form, which includes the 
PQ subcode information used in Compact Disc mastering.

Instead of entering soundfiles into the Delivery Log, you enter one or 
more Sonic EDLs (Edit Decision Lists) that contain the assembled, edit 
audio you wish to roll off for delivery. To enter EDLs, double-click on the 
Tape name, or use the Item pop-up menu to designate which type of 
item you are adding.

When mastering to CD-R (requires Expanded PQ Code Editing option 
SS-525 or Basic PQ option SS-524), you also have the option of adding 
CD-ROM data items for mixed mode mastering. These options also 
allow you to define and edit PQ subcode information.

 

Archive Log

 

All soundfiles and EDLs created on SonicStudio can be archived to 2-
channel DAT, multi-track digital (not analog), or 8mm tape (Requires 
8mm Tape Drive option SS-423 or 424).
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The Archive Log defines the contents of each Project archive. This can 
consist of EDLs or individual sounds. As with the other Logs, you begin 
by defining the archive tape. Besides wild and time tape options, there is 
a selection for Exabyte (8mm) type, provided that you have Sonic 8mm 
tape drive attached.

Within the tape, you can add EDLs or individual soundfiles. When you 
add an EDL to the listing, the information dialog lets you specify that 
soundfiles used by that EDL will be automatically included in the log. 
You can also add soundfiles in groups by selecting a number of files in 
the Sonic Manager, then return to the Archive Log and click on Get 
Sounds.

Once you finish building the Archive Log, click on the Dump button to 
transfer the log’s contents to digital audio or 8mm (Exabyte) tape. The 
information is stored with all edit information intact, and can be restored 
onto the system at a future time.

 

Restoring Archives

 

To restore an archive from digital audio or 8mm tape, the first step is to 
recover the Project information that contains the Archive Log. This is 
stored at the head of the archive tape.
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To begin the restore process: 

 

1. Select the command Restore Archive from the File menu. 

2. In the Restore Archive dialog, specify the type of archive (Timed 
Tape, Wild Tape, or Exabyte), then click on the Find Archive button.

3. For Wild Tapes, cue and start the tape. 

 

Timed Tape and Exabyte archives search by themselves.

When the Project file has been found and loaded, the system will alert 
you. 

 

4. Click on the Open Archive button. 

 

This opens the Archive Log of the Project as a Restore Log. From this 
window you can select and restore any or all items in the archive.

 

The Background Queue Manager

 

Various operations of SonicStudio are executed in the background, 
allowing the user to continue editing while these operations are 
proceeding. Dumping of delivery and archive logs, machine-controlled 
and wild recording, DSP and NoNOISE

 

®

 

 processing can all be 
performed in the background, depending on system options. The 
Background Queue Manager lets you monitor the progress of all 
background processes.
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To open the Background Queue Manager, select the command 
Background Manager from the Managers submenu to the File menu. The 
fields of this window let you monitor the progress of any background 
process, as well as manage a queue of background processes.

If you launch a series of background jobs in succession, the queue 
displays the list of jobs. As one background task is completed, the 
system will automatically launch the next one in order.

 

The Status Monitor Windows

 

The three status monitors, opened from the Status Monitors submenu to 
the File menu, contain information useful in the operation of the system.
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CD Status

 

This window indicates the current state of the option CD-R recorder. 
(Requires CD Printer option CD-200.) 

 

Time Code Status

 

The Time Code Status window displays the current time and format of 
the system’s time code input and output.

 

Sonic Status Listing

 

The Sonic Status Listing provides a constant assessment of the progress 
of all system functions.
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As SonicStudio operates, it posts messages into this window that 
indicate the progress and status of various operations. This trail of 
internal system information is useful in diagnosing any questionable 
behaviors in the system.
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2

 

Menu Command Reference

 

File Menu

 

The File menu includes all commands that create, open, or save 
SonicStudio documents such as soundfiles, edit decision lists, Projects, 
and desk automation Sessions.
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New 

 

The New command at the top of the menu has a submenu to provide for 
creation of the four types of documents used in SonicStudio.

 

New Edit List

 

This command creates an empty Edit Decision List (EDL) on-screen. The 
operation of the EDL window is described in the previous chapter.
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New Sound File...

 

This command initiates recording a soundfile using the Record Sound 
File dialog. Its operation is described in detail in the following chapter.

 

New Project...

 

A SonicStudio Project organizes the soundfiles, EDLs, and desk 
automation Sessions for a particular job, and controls the processes of 
automatic loading, dumping, and archiving.

The Project Manager is controlled by a combination of windows and 
dialogs. Descriptions of the operation of these are found in the chapters 
preceding and following this one.

 

New Desk Session

 

When you select New Desk Session, the Mix Desk window is prepared 
to record automation data. The operation of mix automation is described 
in the preceding chapter.

 

Open 

 

When there are EDLs, soundfiles, and so on that have already been 
created, the Open submenu is used to re-open the various document 
types.

 

Open Edit List

 

Open Edit List brings up the standard Mac Browser dialog that lets you 
navigate to different disk volumes and folders in the Macintosh file 
system.
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The selected EDL will open onto the screen in the state in which it was 
last saved.

 

Open Sound File

 

Soundfiles may be opened into an EDL using this command, or using 
the Sonic Manager which is described in the next chapter. This command 
is available when an EDL window is in the foreground on the screen. If 
there is no EDL open, or if the EDL is not at the front of the screen, the 
command is disabled.

Since soundfiles are stored on the Sonic sound disk rather than the 
Macintosh’ hard disks, a special dialog is used. When you select the 
command, the system will “scan” all mounted sound disks before 
opening the soundfile select dialog.



SonicStudio Version 5 2-5

Menu Command Reference

 

Mount Edit List

 

Mounting an Edit List (EDL) means to insert one EDL into another. In 
editing, it is often useful to assemble a group of items and then insert 
them as a single unit into a new edit list. This command lets you open an 
entire EDL into another EDL as though it were a single soundfile. If 
there is not an EDL currently open, the Mount Edit List command is not 
enabled.

When you select this command, the system brings up a Macintosh file 
select dialog just as for opening an EDL (see above). When you select an 
EDL, the selected EDL opens with its topmost panels in the Source 
panels. Other choices are also available: see description of EDL 
Preferences in the next chapter.

 

Open Project

 

Projects conveniently group the materials used in a single job. Only one 
Project may be open at a time. If a Project is open already, this command 
is disabled. The use of the Project Manager's windows and dialogs is 
described in the chapters preceding and following this one.

 

Open Desk Session

 

Mix automation Sessions can be stored by name and recalled as desired. 
Operation of mix automation is described in the preceding chapter.

 

Open Video

 

Requires the Sonic Digital Playback (SS-518) option.
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Close

 

Closes the currently selected window or document (EDL, Project.) If the 
Mixing Desk is selected and a mix automation Session is open, the 
Session will close.

 

Save

 

Saves the EDL, Project or Session document from the currently selected 
window.

When saving an EDL that is already present on disk, SonicStudio does 
not overwrite the previous version of the EDL, but keeps it with a tag of 
“.s1” added to the name of the EDL. As you do more editing a save your 
changes, the system maintains the last three versions as “xxx.s1, .s2, .s3.” 
This allows you to return to a previous version of your work if needed.

 

Save As

 

Saves a copy of the current document, with user option to change name 
and folder location. This makes it convenient to create multiple versions 
of an EDL or other document, starting from a common base.



SonicStudio Version 5 2-7

Menu Command Reference

 

Record Sound File

 

Opens the Record Sound File dialog to begin the process of recording. 
Record Sound File... is the same function as New Sound File. Operation 
of the Record Sound File dialog is described in the next chapter.

 

Restore Archive

 

Opens the Restore Archive dialog to allow restoration of DAT and 
Exabyte archives. The operation of restoring archives is described in the 
preceding chapter.

 

Transport Panel

 

Opens the Transport Panel. The use of the Transport Panel is described 
in detail in the preceding chapter.

 

Preferences 

 

SonicStudio provides many ways to customize its operation to your 
needs and preferences. The individual preferences items are accessed 
from the Preferences submenu.
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The user preference dialogs and the parameters they control are 
described in detail in the following chapter.

 

Managers 

 

SonicStudio provides two specialized windows known as Managers. 
These windows are described in detail in the preceding chapter.

 

Background Manager

 

The Background Manager provides monitoring and control for load, 
dump, archive, DSP, and NoNOISE processes that are performed in 
background mode.
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Sonic Manager

 

The Sonic Manager window provides library, disk, and file management 
for soundfiles, Cues, EDLs, disk volumes, Projects, automation Sessions, 
and video clips. Disk volumes include both local and remote via the 
MediaNet™ network option.

 

Status Monitors

 

Status Monitors are special windows that give you information on 
current operation of particular systems’ functions. The individual Status 
Monitor windows are described in detail in the preceding chapter.

 

CD Status

 

If your system is equipped for direct output to recordable CD, the CD 
Status Monitor shows the current status and progress of operations on 
the CD recorder. Support for CD writing requires the START Labs™ CD 
Printer (CD-200) as well either the PQ Basic (SS-514) or Expanded PQ 
Code Editing/CD Audio (SS-515) software options.

 

Time Code Status

 

When reading or writing SMPTE longitudinal time code with 
SonicStudio, the Time Code Status Monitor displays the current time 
from both the system time code reader and generator.

 

Status Window

 

The Status Window lists various text messages relating to the internal 
operation and status of the system. It is used principally by Sonic 
customer support in confirming diagnosing system operations.
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Utilities 

 

The Utilities Submenu includes a number of miscellaneous commands 
and specialized functions.

 

Open Status File

 

This command opens the current system status information into the 
Status Window for diagnostic use. This “audit trail” is stored as an 
ASCII text file in the same folder as the SonicStudio application. The 
Status Window will appear at the bottom of the screen.
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Print System Info 

 

This is the one submenu command in the system that has its own 
submenu.

The items in this list are used by Sonic Solutions program developers, 
and occasionally by customer support to list specific types of internal 
system information to the Status Window, where it can be used for 
diagnostic purposes.

 

Video Info

 

Requires Sonic Digital Playback (SS-518) option.

 

CD Compare

 

Requires CD-ROM Reader SS-422 and START Labs™ CD Printer CD-
200. CD Compare operation is described in the next chapter.
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Measure TC Rate/Format

 

In case of time code of unknown rate and format, use this command to 
directly measure the rate of the code and its format. The values derived 
are applied to the System Time Display parameter in the System 
Preferences dialog.

 

SCSI Copy

 

Use this command to directly copy the contents of a SCSI hard drive to 
another SCSI device, such as START Labs™ CD Printer (CD-200). This is 
most often used for mastering of CD-ROM. Supported formats include 
HFS, ISO9660, CD-i and CD-ROM XA.

SCSI Copy operation is described in the next chapter.

 

Sync Sound Disks

 

Use this command to force the system to update its directories of the 
mounted sound disks.

 

Unhang Sound Disks

 

Use this command if your sound drives become hung, refusing to 
respond to Sonic commands. Note that hanging sound drives generally 
indicates a connection, cabling, or termination problem in the SCSI 
chain. If hanging occurs, carefully check the status of every device, cable, 
and terminator in the chain for valid configuration and secure seating.

 

Open TTA File
Close TTA File
Encode TTA Info

 

These commands allow encoding of textual information into the 
specialized “TTA” audio-stream coding used for digital audio 
cable/satellite subscription service. These commands require the TTA 
encoding option.
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Create Video CD File
Create and Mux Video CD File
Dump Video CD

 

Require SonicCinema options SS-101, 103, or 104.

 

Page Setup

 

The Page Setup command brings up a Macintosh-standard dialog for 
controlling your hard-copy print device. This command requires 
connection to a Macintosh Chooser–level printer.

 

Print One

 

When there is printable document on screen, such as a formatted EDL, 
Source Log, Archive Log, or Delivery Log on-screen, Print One will 
deliver the selected document to your hard-copy print device. This 
command requires connection to a Macintosh Chooser–level printer.

 

Print

 

Page Setup..., Print One, and Print commands are part of the standard 
Macintosh File menu command set. In SonicStudio, the Print... command 
is not active.
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Import
Export

 

Import and Export commands are not active in this version.

 

Template 

 

Requires Expanded PQ Editing/CD Audio option (SS-525). Operation is 
described in the manual for that option.

 

Quit

 

 

Quits the SonicStudio application.
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Edit Menu

 

The commands in the Edit menu are used to cut, splice, rearrange, and 
modify digital audio in a Sonic edit decision list window.

Most of the commands in this menu are not available unless there is an 
edit list open and active on-screen. Some of the commands become 
active when certain conditions, such as the presence of a require mark in 
a selected panel, are fulfilled.

 

Undo (Can’t Undo)
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Undo is part of the Macintosh-standard Edit menu structure. In 
SonicStudio, most undo operations are handled with the Undo Edit 
command below.

 

Undo Edit

 

When editing in a Sonic EDL, a list of edits performed is stored as you 
work. By invoking Undo Edit, you can move one step at a time 
backwards through this list, undoing edits one at a time. This makes it 
very easy to try out edits and then revert to a previous state, with option 
to save various versions for subsequent reference.

 

Redo Edit

 

Redo Edit becomes available whenever you have used Undo Edit. It is a 
single-level operation. You can only Redo the last edit that was Undone.

 

Cut, Copy, and Paste

 

In SonicStudio Cut, Copy, and Paste commands operate on selected 
audio segments exclusively. Use these commands to move segments or 
groups of segments between panels of an EDL, or between different 
EDLs.
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Clear

 

The Clear command is part of the standard Macintosh Edit menu 
structure. It is not used in SonicStudio.

 

Select Segments 

 

Individual audio segments in an EDL may be selected by option-clicking 
on the desired segment with the mouse, or by simply clicking with the 
Segment tool. The commands in the Select Segments submenu allow you 
to select groups of segments defined by their position relative to the left 
and right Gates, and by current status.

 

Select All

 

Select all segments in the currently selected panel or edit group. The key 
command equivalent is 

 

 

 

-A.

 

De-Select All

 

De-select any segments that are currently selected in the selected panel 
or edit group. Key command equivalent is 

 

 

 

-D. De-Select All is very 
useful in preventing inadvertent deletion or moving of segments that 
may be selected but not visible in the current view.
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Select Between Gates

 

Select all segments that lie between the left and right Gates in the 
currently selected panel or edit group.

 

Select Left Gate To End

 

Select all segments in the currently selected panel or edit group, starting 
from the position of the left Gate.

 

Reverse Between Gates

 

Reverse the state of all segments that lie between the left and right Gates 
in the currently selected panel or edit group. Segments that were 
previously selected become un-selected, while un-selected segments 
become selected.

 

Lock Selected Segments
Unlock Selected Segments

 

The Lock and Unlock Selected Segments commands let you define any 
segment or group of segments as locked against editing. Locked 
segments can not be deleted or moved.

 

Name Selected Segments

 

This command allows you to assign a name to a segment without 
reverting to the text view display (as described in the preceding 
chapter).

This command is especially useful when editing audio segments to 
create Cue files. The name of the Cue file is taken directly from that of 
the segment, so being able to assign a name without leaving the 
waveform or bar display mode may be convenient.
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Insert 

 

Insert commands are used to move sections of audio, designated by 
placement of In and Out edit points or by selected audio segments, from 
EDL Source panels to EDL Destination panels.

The two major variations of the Insert command are basic insert and 
insert with ripple. The difference in the effect of these is in what happens 
to audio that follows the area directly affected by the edit.

 

Ins. w/CROSS-FADE
Ins. w/BLACK-FADE
Ins. w/CROSS-FADE IN, BLACK-FADE OUT

 

In the basic insert commands, audio that comes after the area directly 
affected remains in place as before.

Following the Insert command, the length of the Destination panel does 
not change. The designated audio section from the Source panel replaces 
audio in the Destination.
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The command variants define which of the user-editable default fades 
will be applied at the head and tail of the edit.

 

Ins. & Ripple, w/CROSS-FADE
Ins. & Ripple, w/BLACK-FADE

 

Insert & Ripple causes all audio following the point of insert to be 
shifted forward to accommodate the section inserted.

When you use Insert w/Ripple, the audio in the Destination panel is not 
replaced, but simply shifted to the right to accommodate the section 
inserted from the Source panel(s).

 

Delete 

 

Delete commands operate analogously to Insert, but they operate only 
on the selected panel’s Edit group. Use these commands to delete 
sections of audio defined by placement of In and Out edit points in the 
target panel(s), or by selecting audio segments that you wish to delete.
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Del. w/CROSS-FADE
Del. w/BLACK-FADE

 

As with the Insert commands, Delete has basic delete (without ripple), 
and delete with ripple options. Basic delete leaves all audio in place 
except the portion defined for deletion.

 

Del. & Ripple, w/IN CROSS-FADE
Del. & Ripple, w/OUT BLACK-FADE

 

Delete & Ripple causes all audio following the deleted portion to shift 
forward to close the space left by the deleted audio.

 

Edit Fade...
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The Edit Fade command opens the Edit Fade window to show the 
closest fade (fade-in, fade-out, or cross-fade) to the right of the left Gate 
in the currently selected EDL panel. The Edit Fade window is described 
in detail in the preceding chapter.

 

Create New Crossfade

 

Use the Create New Crossfade command to divide continuous 
soundfiles into individual segments. Place the left Gate at the point in 
the audio that you want to “cut,” or divide the file. Then select Create 
New Crossfade.

A crossfade edit is inserted into the previously continuous soundfile. 
Once divided by this new edit, you can move the sound on either side of 
the crossfade using any of SonicStudio editing commands.
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Delete Crossfades

 

Delete crossfade (between left and right Gate) applies only to cross fades 
that are inserted in continuous audio. If the audio on either side of the 
fade is moved or adjusted in any way, Delete Crossfade will not 
function.

 

Adjust Gain

 

Any selected audio segment or group of segments can be adjusted in 
level, with absolute gain, relative gain, and normalization options. The 
operation of the command is described in detail in the next chapter.

 

Offset 

 

The commands in the Offset submenu allow you to shift selected 
segments forward or back in their EDL panel, placing the segments at a 
point defined by the command option selected. If there are no selected 
segments in the track, then the entire track will be moved.

The two reference points available in the segments are the left edge 
(earliest sample) of the segment or the position of a Sync Mark placed 
within the segment.
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Left Edge to Wherever

 

When you select Left Edge to Wherever, a dialog pops up into which 
you can enter a time value. The selected segment is moved so that the 
left edge of the segments aligns at the time you have entered.

 

Left Edge to Left Gate

 

When you select Left Edge to Left Gate, the selected segment is moved 
so that the beginning (left edge) of the segment aligns with the position 
of the left Gate.

 

Sync Mark to Wherever
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By placing an editing mark of the “Sync” type in the selected segment, 
you can move the segment to a new position referenced to the position 
of the mark within the segment. This can be used, for example, to place 
a sound effect so that the “hit point” aligns with a particular video 
frame.

 

Sync Mark to Left Gate

 

Sync Mark to Left Gate moves the selected segment so that the position 
of the Sync Mark within the segment aligns with the position of the left 
Gate.

 

Nudge 

 

Nudge Segment Right
Nudge Segment Left

 

Use the Nudge commands to shift a selected audio segment or group of 
segments forwards or backwards in time by a preset amount. Use the 
Nudge Preferences dialog (described in the next chapter) to specify the 
increment of time for nudging.

 

Create Segments 

 

Use the Create Segments commands to divide continuous audio into 
multiple audio segments that can be individually moved and edited. You 
have the option of dividing audio based on the current position of the 
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left and right Gates in the selected panel (Use Gates), or dividing audio 
according to the positions of multiple Segment Start and Segment End 
marks.

When using the three marks-oriented variants of Create Segments, you 
have the option of dividing audio by new cross fades without further 
effect (In Place), or you can elect to delete all audio portions not included 
between a Segment Start and a Segment End mark (With Delete and 
With Delete-Ripple).

 

(Create Segments) From Gates

 

This command places a new crossfade at the position of the left and right 
Gates. Thus, a new segment is created between the positions of the two 
Gates. This segment can then be moved or adjusted independently of the 
audio on either side.

 

(Create Segments) In Place

 

When you select one of these commands (except the From Gates 
command, which ignores the marks), the system will place a crossfade at 
the position of each Segment Start or Segment End mark.
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The specific Create Segment option determines how the audio between 
the newly defined segments is treated. The figure above shows a section 
of audio with alternating Segment Start and End marks.

If you select (Create Segments) In Place, then all audio is left in place. 
Crossfades are placed at the position of the segment mark and the areas 
that lie between a Segment Start and a Segment End mark are left 
selected.

 

(Create Segments) With Delete

 

If the Create Segment option you select is With Delete, then the sections 
or audio that lie between the End point and the next Start are deleted, an 
efficient way to eliminate multiple sections of unwanted sound.

 

(Create Segments) With Delete-Ripple

 

If you choose (create segments) With Delete-Ripple, then the undesired 
sections of sound are deleted, and the remaining segments slide forward 
in time so that they butt up one against the other. This can be useful, for 
example, in reducing a recording of individual sound effects into a 
compact group of sound segments that can be manipulated as desired.
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Loop and Fill

 

Use Loop and Fill to place multiple copies of a designated section of 
sound, marked by In/Out edit points, from the Source edit group into a 
space defined by In/Out points in the Destination panels.

When you invoke this command, it inserts as many copies of the Source 
section (defined by In and Out points or by selected segments) as are 
required to fill the space between the In and Out points in the 
Destination panel.

 

Synchronize 

 

Use the commands in the Synchronize submenu to shift the relative 
position of audio in the Source and Destination panels so that 
designated points in each group line up to the same position in time.
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Sync to Left Gates

 

When you invoke Sync to Left Gates, audio in the Source edit group 
panels is shifted as follows: the position of Source panel’s left Gate is 
noted, then the audio in the Source panels is moved to the position of 
the left Gate in the Destination panels using the Source panel’s original 
left Gate position.

 

Fast Sync to Matching
Sync to Matching

 

When sections of audio in the Source group panels and the Destination 
panels match each other closely, you can use these commands to align 
matching portions of audio in the two panels. This match is performed 
through DSP auto-correlation, and can be used to match audio that 
doesn't match perfectly but is close.
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To sync to matching audio, place the left Gates in each group of panels 
as close as you can to points that visibly match, then select one of the 
two commands. Because of the variety of circumstance and degrees of 
level, phase, and spectral mismatch, you may have to try both 
commands, as well as different locations for the Gates, to get the desired 
results.

 

Mount Source In Sync

 

Sometimes when editing with an audio segment or cue taken from a 
longer soundfile, you may wish to access the parent soundfile in order to 
grab an additional section of audio.

Select a segment then use this command to open the parent soundfile 
into the Source panel group. The file will open in position precisely 
aligned with the audio segment selected.

 

Split & Roll Back Edit
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This command performs a similar function to Mount Source in Sync, but 
it takes it one step further by removing the designated segment from the 
Destination panels and marking its position, in both Source and 
Destination panels, with new In and Out edit points.

This allows an edit to be undone long after the Undo Edit ability is past. 
The left Gate must be placed just to the left of the edit you wish to split.

 

EDL Menu

 

Use the commands in the EDL menu to control the editing display, 
shifting size and display types of the individual panels of an edit 
decision list.

Commands at the bottom of the menu also let you format and print an 
EDL in textual format, and define selected audio segments as Sonic 
“Cue” files. Cues are described in the Window Reference chapter.
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One Timeline

 

With this command, you have the option of displaying time-scale marks 
on every panel of the EDL, or of showing the timeline only as a single 
scale at the top of the window.

Using a single timeline reduces the amount of clutter in the individual 
panel, and allows greater waveform detail to be shown for a given panel 
size.

With One Timeline selected, the time scale at top displays the 
appropriate time for the currently selected Sync group.

 

Resize Panels

 

Use the commands in this submenu to designate the size in which you 
want to display the selected panel or panels.
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There are five display size options that allow you to pack more panels 
into the display space available, or enlarge individual panels or groups 
for detailed examination. Display sizes may be applied to text mode 
displays, as well as waveform, bar, and other display formats.

 

Tiny

 

The Tiny display size lets you pack the maximum number of panels into 
a given display area. Tiny size is available for the waveform and bar 
display modes, but not for text mode. When using the Tiny size, you 
may wish to switch of “Show Times” in the EDL Preferences Display 
section. Tiny size is particularly useful in bar mode.

 

Small

 

As the name implies, the small display size is compact but provides 
good resolution of the waveform display. Greater visibility of detail in 
the waveform is obtained if you switch to One Timeline (see above) and 
turn off “Show Times” in EDL Preferences.
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Standard

 

Standard size is comfortable for most waveform displays, with or 
without timeline and time display in each panel.

 

Large

 

The Large size provides exaggerated vertical scale in the waveform 
display, but is especially useful using the text list view.
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Full

 

The Full size can be used to extend the view of an EDL text list to see 
many entries at once without scrolling. This view may also be used with 
the waveform display mode if extreme vertical detail is required.

 

Display Panels As 

 

In SonicStudio, you can define individual editing panels for display in 
one of several modes.
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Waveform, Bar, and Text modes may be applied to a panel at any time. 
Frequency Analysis display is available only when there has been a 
frequency analysis performed, from the DSP menu, on a region of the 
currently selected panel.

 

Waveform

 

Waveform display is the initial default state, and is the most commonly 
used mode for editing.

As shown in the menu, you may use the command key 

 

 

 

-Y to switch the 
selected panel to waveform display from any other mode.

 

Frequency Analysis

 

The Frequency Analysis display mode is available only when the Do 
Frequency Analysis command from the DSP menu has been performed 
on a section of audio in the panel. The Frequency Analysis display 
shows frequency content on a horizontal scale from low to high. 
Although you cannot edit the Frequency Analysis display, you can use 
any of the View menu commands to zoom in and view any area of the 
display in detail.

 

Bar
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The Bar mode shows audio segments with their text labels, but without 
waveforms. This may be very useful when dealing with sound that is 
divided into many discrete chunks, as in sound effect or dialog assembly

 

Text

 

The Text view display mode provides a complete alternative editing 
environment. Audio segments are displayed as a horizontal row, with 
information describing the start and stop of the segments, their gain and 
so on. Editing in the Text mode is described in detail in the preceding 
chapter.

 

Estimate

 

Estimate display mode is available only in conjunction with the 
Broadband Denoising module of NoNOISE.

 

Swap Panels

 

Use this command to exchange the screen position of two selected 
panels. If there is only one selected panel, the command is unavailable
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Refresh Plot

 

Use this command to force an update of the edit display to the most 
current information.

 

Format EDL

 

When you invoke this command, a new formatted edit list window will 
appear on-screen, containing all the information in the currently selected 
EDL in textual, printable form.
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Make Cue Files

 

A Cue contains all of the information that defines a segment, including 
the source soundfile, and may be used and thought of as the segment 
itself.
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After you make a Cue file, you must hit the “Scan” button in the Cue 
library of the Sonic Manager to make the new file appear. From the Cue 
library, you can place cues as desired into your EDL.

Note that the first time you create a Cue, the system will ask you to 
define a path (folder) in which to store the cue. All subsequently created 
cues will follow this placement. You can redefine the folder used for 
storing cues at any time from the Sonic Manager library.

 

Cue Placement

 

When you select the Cue Placement command, it opens the Place dialog. 
This dialog determines where Cue files will be placed in time when you 
drag them into an EDL panel from the Sonic Manager.
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There are four placement modes available. Placement of Cues by drag 
and drop, and the operation of these modes, is discussed in the section 
of this chapter that describes the EDL.

 

•

 

Place according to mouse position at time the button is released.

 

•

 

Place according to the position of the edit In and/or Out points.

 

•

 

Place according to the play head (Transport Panel) time.

 

•

 

Place according to the time stamp of the cue.

The four modes are represented by icons in the Cue Placement select 
dialog. As you point at each icon with the mouse, the name of the mode 
it selects is listed at the bottom of the dialog. The mode you select 
remains in effect until you change it by opening Cue Placement again.

 

Play Menu

 

In SonicStudio, there are many ways to start and stop playback of audio, 
from the menu or from the keyboard.
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The Play menu commands let you play all or any designated portion of 
a Sonic edit list.

 

(Play) Between Gates

 

Use this command to play audio between the left and right Gates on the 
currently selected panel or edit group.

 

(Play) Around Gates’ Center

 

Use these commands to play a section of audio centered between the left 
and right Gates on the selected panel.

The time interval indicated by the submenu command defines the length 
of segment played. The audition area is always centered between the 
Gates.

Play from here........................... ......................to here
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(Play) From Left Gate 

 

These commands play a portion of audio starting from the position of 
the left Gate in the select panel or group.

As with playing around the Gates’ center, the submenu option defines 
the length of the portion played in seconds.

 

(Play) To Right Gate 

 

Use these commands to play a section of audio ending at the position of 
the right Gate.

Play defined interval to either side of center point 
between gates

Play defined interval starting from the left gate
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Again, the specific submenu command selected defines the length of the 
auditioned section.

 

(Play) To In Point

 

Use this command to play a section leading up to the current position of 
an In edit point.

The length of the auditioned section is determined in the Audition 
section of the EDL Preferences dialog.

Play defined interval up to the right gate

Play up to the In point. Duration of play is defined in 
EDL Preferences, Audition section.
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(Play) From In Point

 

Plays a portion of audio starting from the current In point.

Length of auditioned section is determined in EDL Preferences.

 

(Play) To Out Point

 

Plays a portion of audio, length determined by the setting of EDL 
Preferences, leading up to the current Out point position.

 

(Play) From Out Point

Play starting from the In point. Duration of play is 
defined in EDL Preferences, Audition section.

Play up to the Out point. Duration of play is defined 
in EDL Preferences, Audition section.
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Plays an audio section, as set in EDL Preferences, starting from the 
current Out point position.

 

(Play) From Play Head

 

“Play Head” refers to current time position as shown in the Transport 
Panel time display window. This command initiates playback starting 
from that point and continuing to the end of the EDL.

 

(Play) Between In & Out points

 

Plays back the audio section between the present locations of the In and 
Out edit points.

Play starting from the Out point. Duration of play is 
defined in EDL Preferences, Audition section.
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(Play) All

 

Plays back all of the selected panel or group, starting from the 
beginning.

 

Reel Rock

 

The Reel Rock places the system in audio scrub mode. Using reel-rock, 
you can move at slow speed within a panel and locate the starting point 
of attacks and other features.

 

Varispeed On Playback

Play from In point position to Out point

Play from beginning of panel to the end
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This command causes SonicStudio to modify outgoing digital audio data 
for playback at a different sample rate from the current value. This 
command requires the Varispeed/Sample Rate Conversion option.

 

Stop Play

 

Immediately stops any play in progress.

 

Reserve Bandwidth

 

Requires the MediaNet option MN-1101, 1102, 1201, or 1202.

 

Mark Menu

 

Use the commands in the Mark menu to place or move edit points (In 
and Out) and general-purpose editing marks.

In SonicStudio, you can place a variety of different kinds of marks in an 
editing panel and use these to control various editing and mastering 
operations.

There are two principle classes of markings used. Use In and/or Out edit 
points to define the positions of start and end points for edit operations 
such as Insert and Delete. Use Marks (Segment Start/End, etc.) to mark 
locations for other purposes or general reference.
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Set In Point/Set Out Point

 

Use these commands to set In and Out editing points “on-the-fly.” If 
selected during audio playback, the designated point is placed at the 
current location of the play pointer. If selected while stopped, the 
designate edit point is placed at the position of the left (In point) or right 
(Out point) Gate.

 

Set In & Out Points

 

This command efficiently places both In and Out points at the current 
positions of the left and right Gates in the selected panel or group.

 

Clear In/Out/Both Points

 

These commands clear the edit points from the selected panels.

 

Move In Point/Out Point

 

Use these commands to set In or Out edit points at specific time 
locations. A dialog box appears in which you enter an arbitrary time.
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Move In Point to Out Point

 

Use to exchange the positions of the In and Out edit points. When 
invoked, the In edit point is placed at the previous position of the Out 
point.

 

Find & Set Points

 

Use this command to automatically set In and Out edit points at the 
boundaries of an existing segment. Place the left Gate within a segment, 
then invoke the command. In and Out edit points are placed at the edit 
event times for the To and From Black fades that define that segment.

 

Mark 

 

Use the selections in this submenu to place any of the several types of 
general purpose marks within an edit panel.

If play is in progress, the selected mark type appears at the current play 
position. If playback is stopped, the position of the left Gate controls 
mark placement.
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Erase Mark

 

Eliminates the mark or marks enclosed by the left and right Gates.

 

MarkInfo

 

Opens the MarkInfo dialog, described in the Dialog Reference chapter, 
for the mark closest to the left Gate.

 

Edited/Analog Black To Marks

 

Use these commands to place edit marks in a panel automatically. When 
invoked, these commands scan the selected panel or group and enter 
marks at the start and end of active audio, eliminating areas of silence. 
The Edited Black option places marks strictly according to edits which 
you have performed. These commands work with audio between the 
Gates.

For Analog Black To Marks, the type of mark that is created is controlled 
in the resulting dialog. That dialog also provides for threshold amplitude 
and minimum length used to recognize areas of “silence.” This 
command can be used to automatically create amplitude specific 
segments in conjunction with the Create Segments command.
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Project To Marks

 

Requires the EDL Translator option SS-505.

 

Nudge Right/Nudge Left 

 

Use the commands in this submenu to move the In and Out edit points 
forward or back in time by a fixed increment.

The value of the increment used is defined in the Nudge Preferences 
dialog.

 

View Menu

 

Use the commands in the View menu to navigate and zoom in or out to 
any portion of the waveform or bar editing display.
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The first commands in the menu let you move your view to different 
areas of the current selected panel without changing zoom level. Use the 
commands in the bottom portion of the menu to change zoom level and 
move to different locations at defined zoom settings.

 

Move Forward/Move Backward

 

Use these commands to move the current view of the selected panel or 
sync group forward or backward. The view is always moved such that 
the display overlaps the previous view.

 

Move To 

 

Use the commands in this submenu to move the current view to an area 
of the panel defined by a feature of that panel, such as the position of an 
editing mark.
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The submenu options determine the feature or other definition of the 
area to which the current view is moved.

 

Move to Left Gate
Move to Right Gate

 

Moves the current view so that the left or right Gates are placed at the 
left or right edge, respectively, of the selected panel.

 

Move to In Point
Move to Out Point

 

Moves the view so that the In or Out edit points appear in the panel, 
close to the left or right edge respectively.

 

Next Click
Next Restore

 

Require the Production Declicking option NN-103.

 

Next Mark

 

Moves the current view to the position of the next general purpose 
editing mark placed in the selected panel or group.
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Move to Wherever...

 

This command brings up a dialog into which you enter arbitrary values 
for the left and right edges of the view. The panel view then zooms to 
the position defined.

 

Move Left Gate 

 

The Move Left Gate commands shift the position of the left Gate to that 
of an edit, mark, or other feature in the selected panel or group.

The specific submenu option selected defines the new location of the 
Gate.

 

Left Gate to Next Edit

 

Moves the Gate to the position of the next fade (in-, out-, or cross-fade) 
to the right of the prior Gate position.

 

Left Gate to Next Mark

 

Moves the Gate to the position of the next general purpose editing mark

 

Left Gate to In Point
Left Gate to Out Point

 

Moves the Gate to the position of the In or Out edit point

 

Left Gate to End

 

Moves the Gate to the end of the selected panel.
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Left Gate to Peak

 

Use this command to locate the highest peak level (instantaneous sample 
value positive or negative) in the selected panel or group. When you 
invoke this command, it scans audio from the current Gate position 
rightward in all members of the edit group (Source or Destination) of the 
selected panel to identify the highest audio peak. The Gate is then 
moved to this position.

 

Zoom In/Out

 

Use these commands to zoom in or out by a fixed percentage from the 
current view. The amount of zoom is set in the EDL Preferences dialog. 
See the Display section for more information.

 

Zoom To Gates

 

Use this command to zoom the edit view to the area bounded by the 
location of the left and right Gates.

 

Zoom To Previous

 

SonicStudio retains a memory of the last previous view. Use the Zoom 
To Previous command to shift the view level back to the earlier view.
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Zoom Around In Point
Zoom Around Out Point

 

Use these commands to zoom around the location of the In or Out edit 
points. The amount of time displayed to either side of the designated 
point is defined in EDL Preferences. See the Display section for more 
information.

 

The Around Gates’ Center submenu

 

Use these commands to zoom to an area around the exact center of the 
left and right Gate positions.

The submenu options define the length of the area viewed.

 

Zoom To Segment

 

Use this command to zoom the display to frame the selected audio 
segment or segments.
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Zoom To Entire Track

 

Use this command to zoom out to show the entire length of the current 
selected panel.

 

Zoom To Entire EDL

 

Use this command to zoom the selected panel out to show the length of 
the longest panel in the EDL.

 

Desk Menu

 

The commands in the Desk menu are used to control mix automation 
and desk presets used during EDL-based recording.
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The upper portion of the menu controls record/playback setups, while 
the bottom five commands apply to mix automation. These commands 
become active when an automation Session is opened or created.

 

Use Playback/Record Desk
Make Playback/Record Setup

 

Use these commands to define and recall the two setups of the mixing 
desk routing and levels used in playback and punch-in recording. The 
use of these setups in recording is described in the Window Reference 
chapter.
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Automation Commands

 

The commands in this section provide a simple, but highly flexible Desk 
automation system.

To begin a desk automation Session:

 

•

 

From the File menu, select the command New Desk Session

When you create a new Desk Session, the name of the Session appears at 
the top of the Desk's Channel Fade section, and the commands in the 
Automation section of the Desk menu become active.

 

Automation

 

Select this command to activate mix automation. When you select this 
command, a check mark will appear beside it in the menu. So long as 
this check mark shows, automation is in effect.

With automation activated, changes to the mixing desk are recorded 
automatically as you play audio from the EDL. All changes to the 
position of faders and pan pots are recorded.

Likewise with automation on, whenever you play the EDL the mixing 
moves recorded are played back automatically.

If the Mixing Desk (SS-201) software option is installed, automation is 
expanded to cover changes to filters and dynamics processing, as well as 
to fader and pan pot position. Otherwise, automation affects only level, 
pan, and channel muting.
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Undo Pass
Redo Pass

 

Each time that you make changes in the mixing moves recorded in a 
Session, a new automation “pass” is created. Using the Undo Pass and 
Redo Pass commands, you can revert to a previous version of your mix 
Session to add to or change the moves up to that point.

 

End Pass

 

If you have created multiple automation passes, and used the 
Undo/Redo commands to move back in the sequence of passes you can 
use this command to jump forward to the very last pass created.

 

Take SnapShot

 

The Sonic mixing automation stores mix info in two forms. Dynamic 
automation moves are recorded during playback, by moving the Desk 
faders and pots.

Snapshots may be recorded while the system is stopped or on the fly 
during playback. A snapshot records the position of all faders, mutes, 
and pan pots as a single memory. When playing back, at the point that a 
SnapShot is located all the controls will jump to the positions stored in 
the SnapShot

To record a mix SnapShot at a particular location

 

1. Play the EDL to the point at which you wish to insert the SnapShot.

 

The time that appears in the Transport Panel's window is the time at 
which the SnapShot will be placed.

 

2. Set the Desk faders, mutes, and panpots exactly as you want them 
to appear.

3. Select the command Take SnapShot from the menu.

 

If there is already a SnapShot at the position selected, that SnapShot is 
replaced by the new one.
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SnapShots may also be placed “on-the-fly” by selecting Take SnapShot 
from the menu while the EDL is playing.

 

Delete SnapShot

 

If you cue to the location at which a SnapShot appears, you can remove 
that SnapShot by using this command.

 

Go To Next SnapShot
Go To Previous SnapShot

 

Go To Next SnapShot will bring you from the current play head 
(Transport Panel) position to the position of the next SnapShot in the 
Session. Likewise Go To Previous SnapShot will move you back from the 
current position to that of the preceding SnapShot.

By using the Go To Next and Go To Previous SnapShot commands 
together with Take SnapShot and Delete SnapShot, you can easily locate 
and replace or modify any automation SnapShot 

 

DSP Menu

 

Use the commands in the DSP menu to set up and launch the specialized 
digital signal processing functions available in SonicStudio.

The operation and availability of commands in the DSP menu depends 
on the hardware and software options installed on the system. 
Frequency analysis and sound reversal are available on all systems, 
while other processing functions are provided as system options.
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If a Sonic FX Processor card (SS-800) is installed, then all non-real-time 
processing is done in background mode. Otherwise, processing is 
performed in foreground mode, and prevents other commands from 
being performed until they are terminated.

 

Do Frequency Analysis

 

Use this command to analyze frequency content of a section of audio 
bounded by the left and right Gates. The analysis display will appear in 
the panel, replacing the previous waveform or bar display. Note: due to 
processing time, it is not recommended that you perform analysis on 
audio lengths greater than 1/2 second.

 

Reverse Sound File 

 

Use these commands to create a new soundfile that reverses the defined 
file or section.

 

Reverse Sound File

 

This command opens the Reverse Sound File dialog, described in detail 
in the Dialog Reference chapter. This dialog lets you specify any desired 
source soundfile, or portion thereof, to be reversed.
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Reverse w/CROSS-FADE
Reverse w/BLACK-FADE
Reverse w/CROSS-FADE IN, BLACK-FADE OUT
Reverse & Ripple, w/CROSS-FADE
Reverse & Ripple, W/BLACK-FADE

 

The remaining options let you reverse sound directly in an EDL. These 
are exactly equivalent to the Insert command in the Edit menu, except 
they reverse the sound as it is placed. All you do is set In and Out points 
in Source and Destination panels.

When you invoke the Reverse command, it performs an Insert edit, but 
at the same time launches the reverse process. When you invoke the 
command, a “garbage” waveform initially appears at the sit where you 
are placing the new audio. After an interval of time, the reversed sound 
appears at the designated location in the Destination panel.

 

Pitch Shift 

 

(Requires software option Time Twist/Pitch Shift SS-806) 

 

Additional 
details on operation is found in the manual for that option.

 

P.S. Specifications

 

When you invoke this command, it opens the Pitch Shift dialog to let 
you specify a soundfile to be processed, along with the pitch shift 
interval and other parameters. The operation of this dialog is explained 
in the next chapter.
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P.S. w/CROSS-FADE
P.S. w/BLACK-FADE
P.S w/CROSS-FADE IN, BLACK-FADE OUT
P.S. & Ripple, w/CROSS-FADE
P.S. & Ripple, W/BLACK-FADE

 

These commands are editing commands, exactly equivalent to the Insert 
commands in the Edit menu, except that the sound segment being 
inserted is automatically processed and pitch shifted. The interval of 
pitch shift is taken from the default settings, which you can change by 
opening the Pitch Shift dialog using the P.S. Specification command

When you select one of these commands, it performs an Insert edit, but 
at the same time launches the pitch shift process. When you invoke the 
command, a “garbage” waveform initially appears at the sit where you 
are placing the new audio.

If you have a dedicated effect processing board in your system, the 
actual pitch shift is performed in the background, and you can follow its 
progress by opening the Background Manager window. After an interval 
of time, the pitch shifted sound appears at the designated location in the 
Destination panel.

If you system does not have an effect processing card, the process is 
done in the foreground and locks out other actions until it completes.

 

Time Twist 

 

(Requires software option Time Twist/Pitch Shift SS-806) 

 

Additional 
details on operation is found in the manual for that option.
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T.T. Specifications

 

When you invoke this command, it opens the Launch Time Twist dialog 
to let you specify a soundfile to be processed, along with the ratio of 
time compression/expansion and other parameters. The operation of 
this dialog is explained in the next chapter.

 

T.T. w/CROSS-FADE
T.T. w/BLACK-FADE
T.T. w/CROSS-FADE IN, BLACK-FADE OUT
T.T. & Ripple, w/CROSS-FADE
T.T. & Ripple, W/BLACK-FADE

 

These commands are exactly equivalent to the Insert commands in the 
Edit menu, except that the sound segment being inserted is 
automatically processed and time twisted. The ratio of time twist is 
taken from the default settings, which you can change by opening the 
Launch Time Twist dialog using the T.T. Specification command

When you select one of these commands, it performs an Insert edit, but 
at the same time launches the time twist process. When you invoke the 
command, a “garbage” waveform initially appears at the sit where you 
are placing the new audio.

If you have a dedicated effect processing board in your system, the 
actual time twist is performed in the background, and you can follow its 
progress by opening the Background Manager window. After an interval 
of time, the time twisted sound appears at the designated location in the 
Destination panel.

If you system does not have an effect processing card, the process is 
done in the foreground and locks out other actions until it completes.

 

Reverberation
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(Requires software option Designer Reverberation SS-802 with a 
dedicated effects/NoNOISE processing card) 

 

Additional details found 
in the manual for that option.

When you invoke this command, the reverberation software is loaded 
into the program memory of the effects processing board. It then opens 
the Designer Reverberation dialog (described in the next chapter) for 
control of reverberation parameters and setups.

 

Bkg Sample Rate Conversion 

 

Requires software option Basic Sample Rate Conversion SS-520 or 
Varispeed Sample Rate Conversion SS-500. 

 

Additional details on the 
operation sample rate conversion are found in the manuals for the 
specific options.

This command opens the Background Sample Rate Conversion dialog, 
to launch sample rate conversion of an existing soundfile. Operation of 
this dialog is described in the next chapter.

 

NoNOISE Menu

 

Requires NoNOISE® options, NN-101, 102, 103, 104, 105, 106.

 

Use the NoNOISE menu to perform manual or automated declicking, 
denoising, dekrackling, or complex filtering to restore damaged or 
historical recordings. These commands require one or more of the 
NoNOISE sonic restoration options.
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The operation and use of the NoNOISE modules and commands is 
explained in detail in the NoNOISE options manuals.

 

Windows Menu

 

The Windows menu provides commands to bring any of the currently 
open windows in the system to the front of the screen.

There are three permanent entries in this menu: Desk, EDL, and Project. 
The Desk commands bring all the windows that make up the Sonic 
mixing desk to the front of the screen. The EDL and Project commands 
are active only if there is an EDL or Project open.
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Dialog Reference

 

Many SonicStudio functions bring up a dialog when engaged. These 
dialogs require the user to set parameters for their function.

 

The Record Sound File Dialog

 

Recording with the Record Sound File dialog is an alternate way to load 
sounds in to the system.

In comparison to recording to an EDL panel, it lets you name and define 
soundfiles before recording and record with sample rate conversion. It 
also gives you useful information such as the record time available on 
the currently selected sound disk, and button access to pertinent 
preference dialogs.
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To start a recording using the dialog, select the command Record Sound 
File or New Sound File from the File menu. When you invoke this 
command, the Record Sound File dialog and the Transport Panel appear 
on-screen. The Transport Panel will appear armed and ready to begin 
recording. To start actual recording, click on the Play or Pause buttons in 
the transport controls.

 

Name

 

By default, the soundfile to be recorded is named according to the 
settings in the Recording Path Preferences dialog. If you like, you may 
enter a new name before starting to record or access the Path Preferences 
by clicking on the Auto Name Settings button.

 

Soundfile Duration

 

You may optionally enter a value for the duration of the recording. If 
you enter a value other than 00:00:00:00 here, the system will 
automatically terminate the recording after the allotted time.

 

Time Now

 

During actual recording, the current time (starting from zero) is 
displayed here.

 

Available Record Time

 

Available Record Time shows the amount of recording time available on 
the currently selected disk at the current sample rate, bit resolution, and 
number of channels. To select the disk on which your file will be 
recorded, go to the Record Preferences dialog, which includes a pop-up 
menu of MOFS disk volumes.
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Time Stamp Source

 

Time Stamp Source lets you select a timing reference for recording. The 
choices are SMPTE longitudinal time code, and 9-pin serial time code. If 
you select one of these, a “time stamp” will be appended to the file so 
that the same piece of audio can be reinserted into an EDL according to 
the time code on the original source.

 

Time Stamp

 

The actual time stamp value appears here when the stamp is acquired.

 

Variable Speed/Sample Rate Conversion

 

If you have the Varispeed/Sample Rate Conversion option SS-500, you 
can elect to record with sample rate conversion.

 

Record Prefs. 

 

This opens the Recording Preferences dialog.

 

Auto. Name Setting 

 

This opens the Default Record Path Select dialog.

 

Retake and Rename 

 

These buttons are not used in the present system.

 

Prepare 

 

Clicking this button causes the system to prepare the soundfile, as 
named and (optionally) allocated. The advantage of doing this is a slight 
improvement in the delay when actually starting a recording.
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Project Manager Dialogs

 

The operation of the Project Manager is described in the Window 
Reference chapter. There are a number of data-entry dialogs used in the 
process of creating and using the Source, Delivery, and Archive logs.

 

New Project Dialog

 

The New Project dialog appears when you select New Project from the 
File menu.

 

Customer, Project, and Title fields

 

These fields define the location of storage for soundfile created in 
association with the Project. This hierarchy of folders replaces that 
defined by the Default Record Path Select dialog.

 

Tape Info Dialog (Source Log variant)

 

The Tape Info dialog lets you name and set parameters for Project tape 
reels.
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The key information in this dialog is the Type selection. The Tape Info 
dialog for a Source Log provides two choices, Timed Tape and Wild 
Tape. To use the Timed Tape option, you must have the Machine Control 
option SS-516.

 

Name

 

An arbitrary name. This may reference the name of the tape in your own 
library system.

 

Start Time

 

The earliest time code on the tape.

 

Duration

 

The length of the tape, in minutes. This information is used to limit the 
range of search (for machine-controller operations) and to determine 
when the length of a delivery or archive log exceeds the length of the 
tape available.

 

Comment

 

You may enter your own comments here
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Type

 

There two types of media available for Source tapes. A “Timed Tape” is 
a tape with time code. To use a timed tape, you must have the Machine 
Control option (SS-516) and a deck with serial control capabilities.

A “Wild Tape” is any tape that is not subject to machine control.

 

Tape Info Dialog (delivery variant)

 

In the case of a Delivery Log, the Tape Info dialog provides more choices 
of media.

Depending on system options, you can deliver to wild tape (without 
serial control), timed tape (controlled by SonicStudio using serial RS-
422), recordable, or 8mm tape in DDP format. Additionally, you can 
specify if the output will be formatted for CD mastering, including PQ 
subcode information.

 

Name

 

An arbitrary name. This may reference the name of the tape in your own 
library system.

 

Mastering Info 

 

Opens the Mastering Info dialog, described below.
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Start Time

 

The earliest time code on the tape.

 

Duration

 

The length of the tape, in minutes. This information is used to limit the 
range of search (for machine-controller operations) and to determine 
when the length of a delivery or archive log exceeds the length of the 
tape available.

 

Comment

 

You may enter your own comments here

 

Desk Dump 

 

Applies only to transfers to recordable CD. When this box is selected, the 
audio transfer is routed through the mixing desk, where it can be 
subjected to automated or manual gain change and equalization. When 
adding an EDL to the Log, you have the option of designating a desk 
automation Session to be used with the dump. Otherwise, you may 
manipulate the desk manually in the course of the dump.

 

Double Speed

 

Applies only to transfers to recordable CD. When this box is selected, 
audio transfer to CD-R will process at twice real-time.

 

Type

 

A “Timed Tape” is a tape with time code. To use a timed tape, you must 
have the Machine Control option (SS-516) and a deck with serial control 
capabilities.

A “Wild Tape” is any tape that is not subject to machine control.

For a Delivery Log, you also have the option of specifying type “CD,” 
meaning recordable CD using the START Labs™ CD Printer (CD-200).
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Format

 

Requires Basic (SS-524) or Expanded PQ Code Editing / CD Audio 
(SS-525) option.

 

 You may define the format of the output as either 
Reference or Premaster. The difference is that a Premaster output 
includes the “PQ Burst” information for CD mastering.

For a Wild or Timed Tape, a separate transfer step is incorporated in the 
dump procedure to record this burst in audio form onto an analog track 
of the standard Umatic CD master.

In the case of CD-R, the PQ information is incorporated within the 
dump, and is invisible to the operator during transfer or playback of the 
finished CD-R

If you have the SonicCinema system (SC-101), the additional option of 
Video CD is available. Video CDs are 

 

always

 

 in Premaster format.

 

Flow CD 

 

Requires Basic (SS-524) or Expanded PQ Code Editing / CD Audio 
(SS-525) option.

 

 With this checkbox set, you may create a CD by direct 
transfer from a standard Umatic master. This procedure is described in 
the manual for the PQ editing/CD mastering options

 

Mastering Info Dialog
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The Mastering Info dialog is used to provide information required for 
the information that is embedded in a Premaster CD. This information 
applies only to Premaster CDs, and may not be required by your 
pressing plant.

 

Disc Name

 

The title of the CD being prepared.

 

Producer Name

 

The name of the producer.

 

Copyright Holder Name

 

The name of the holder of the legal copyright.

 

Tape Info Dialog (archive variant)

 

For archiving, the tape info dialog provides options for Time Tape or 
Wild Tape types. In systems equipped with 8mm tape drives, the 
additional choice of “Exabyte” (8mm) type is available.

In multi-channel systems, you can archive one board’s worth of 
soundfiles at a time to DAT or send them all in parallel to a multi-track 
digital audio recording. The pop-up menu at bottom lets you select 
which board will output the archive.
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Name

 

An arbitrary name. This may reference the name of the tape in your own 
library system.

 

Start Time

 

The earliest time code on the tape.

 

Duration

 

The length of the tape, in minutes. This information is used to limit the 
range of search (for machine-controller operations) and to determine 
when the length of a delivery or archive log exceeds the length of the 
tape available.

 

Comment

 

You may enter your own comments here

 

Type

 

A “Timed Tape” is a tape with time code. To use a timed tape, you must 
have the Machine Control option (SS-516) and a deck with serial control 
capabilities.

A “Wild Tape” is any tape that is not subject to machine control.

If you have the 8mm Tape Drive (SS-423 or SS-424) for archiving, the 
additional selection of Exabyte tape is available.

 

Board

 

Applies only to multi-track/multi-board SonicStudio systems. When 
archiving to digital tape, you have two options:

 

•

 

If you are using 2-channel digital audio tape (such as DAT), you may 
select the individual boards and archive the contents of the disks on 
that board’s SCSI chain by connecting the tape’s input to the output 
of each board in turn.
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•

 

If you are using a multi-track digital audio recorder, you may select 
“All Boards” and connect the P2 (channels 1/2) of each board to 2 
tracks of your multi-track deck. When you dump the archive, the 
contents of all SCSI chains will be transferred in parallel, greatly 
speeding operation.

 

SoundFile Info Dialog

 

Information on soundfiles used in delivery and archive tape reels is 
accessed via the SoundFile Info dialog.

For loading from timed tape, the start time and the end time or duration 
of the file are the most important items.

 

Name

 

An arbitrary name. This may reference the name of the tape in your own 
library system.
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SoundFile Starts At

 

The time code location at which the desired audio begins.

 

SoundFile Ends At

 

The end of the soundfile may be defined either as an absolute timecode 
value or as a duration from the start time.

 

Comment

 

Available for user comments.

 

Number of Channels

 

Determines the channels that will be loaded. The demand for, and 
terminology of, these buttons derives from the Sony D2 digital video 
machine and other devices that follow its conventions. “All” in this case 
refers to four channel loading.

 

Set Channels button

 

Requires the EDL Translator with Autoconform options (SS-505). 

 

Operation is described in the manual for that option.

 

Cut Info Dialog

 

Within a soundfile, you can specify individual Cuts. The system will 
load one soundfile, but place marks that allow you to identify individual 
cuts.
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Information on Cuts used in delivery and archive tape reels is accessed 
via the Cut Info dialog.

 

Name

 

An arbitrary name. This may reference the name of the tape in your own 
library system.

 

Cut Starts At

 

The time code location at which the desired audio begins

 

Cut Ends At

 

The end of the soundfile may be defined either as an absolute timecode 
value or as a duration from the start time.

 

Archive Info Dialog

 

The Archive Info dialog lets you define how an EDL item will be added 
to the Log.
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Name

 

An arbitrary name. This may reference the name of the tape in your own 
library system.

 

Include All SoundFiles In EDL

 

When this checkbox is selected, the soundfiles that are used in the 
designated EDL are automatically added to the Archive Log.

If you do not use this function, then soundfiles will have to be added to 
the Log by hand. We recommend that convenience of using Include All 
SoundFiles In EDL.

 

Comment

 

Available for user comments.

 

Archive Info Dialog (soundfile variant)
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When adding a soundfile to an Archive Log, the Archive Info dialog 
checkbox reads Include All Channels, rather than include all soundfiles. 
This selection should be used by default.

 

Edit Decision List Info Dialog

 

When adding an EDL to a Delivery Log, you can specify the particular 
archive using this dialog.

For delivery to tape or CD-R, you also need to specify the starting time 
for the EDL, either absolute or relative to the end of the preceding EDL.

 

Name

 

An arbitrary name. This may reference the name of the tape in your own 
library system.

 

EDL Starts At

 

The time code location at which the transfer is to begin

 

Comment

 

Available for user comments.
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The User Preference Dialogs

Audio I/O Preferences Dialog

 

Audio I/O Preferences defines the basic digital input and output 
functions for SonicStudio.

In the Audio I/O Preferences dialog, the SonicStudio 16•24 card and its 
connections to external I/O boxes are depicted in literal form. The 
system scans for responses from the connected peripheral units, so this 
diagram will accurately reflect the boxes that are connected and 
switched on. If any of the connected boxes are 

 

not

 

 switched on, they will 
not appear in the diagram.

By clicking on the images of the various elements (SonicStudio 16•24, 
digital I/O, etc.), you can open dialog boxes to set parameters and 
preferences associated with that element. 

A separate icon image indicates which of the peripheral I/O boxes is 
providing master clock to the system. In the SonicStudio 16•24-based 
SonicStudio, clock is 

 

always

 

 provided by one of the peripheral I/O 
boxes.

Buttons, pop-up menus, and indicators at the top of the dialog provide 
for selecting clock master, storing and recalling setups of the dialog, and 
scanning to update the dialog if the configuration of external I/O 
peripheral boxes changes.
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Selecting the Clock Master

 

In a digital audio system such as SonicStudio that connects to external 
digital audio equipment, the master clock is an important subject. The 
essential point is that every device in the total system must be running 
off of the same clock. If they are not, the result will be harsh noise. Like 
many digital audio devices, SonicStudio is designed to derive it's clock 
from a digital input source, such as DAT or other digital source. 
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The current clock master is indicated by the docking clock icon image in 
Audio I/O Preferences. When you start up the system, the clock master 
is assigned automatically to the first input device. If no input device is 
detected, the selection reverts to the first output device (these have 
crystal oscillators that can provide clock). If no peripheral devices are 
detected, a warning dialog appears. 

To switch the clock master to a different peripheral box:

 

♦

 

Option-click on the image of the device you want to designate as 
the clock master. 

 

The system will not let you designate an output device as clock 
master as long as an input device is available. 

Besides designating which peripheral box is serving as clock master, you 
will need to designate which of inputs of that box will provide the clock. 
You can also specify clocking from an external word clock or internal 
oscillator

To open the Clock Master dialog:

 

1. Click on the Clock Master icon image.

2. Select the input or other clock source to be used. 
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3. Close the dialog.

 

Four-Channel Digital I/O Control Dialog

 

The Four-Channel Digital I/O provides two stereo pairs of inputs and 
outputs on XLR (AES/EBU format), RCA (S/PDIF format) and optical 
(AES Type II) connectors. All outputs operate in parallel, but only one 
digital input can be selected at a time for each stereo input pair. 

To select digital audio input connection type:

 

1. Click on the graphic box representing the device you want to set.

 

 The following dialog will appear.

 

 

2. Click-hold on the Select Input Connection box. 

3. Drag to select your desired input for each of the stereo pairs. 

4. Close the dialog.

Stereo Inputs
1/2 & 3/4

Channel Status
dialog

Select Input Connection

Input Connection Options
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Eight -Channel D/A Converter Control Dialog

 

The Eight-Channel D/A Converter has the capacity for 8 channels of 
analog output, with gain (trim) adjustable via software. 

To adjust the output trim:

 

1. Click on the graphic box representing the D/A-8. 

 

The following dialog will appear.

 

2. Set the channel output volume either individually or for all 
channels at once. 

a. For all channels, click on the All Channels box at the top.

 

A check mark appears in the box. 

 

b. For individual channel, select the channel you want to change.

3. Modify the value by clicking and moving the slider, or typing in 
the value you want. 

 

Selecting Load and Dump Channels

 

Automated stereo load and dump operations require that you designate 
which of the system's inputs and outputs will be used. The SonicStudio 
card's multiplicity of input and outputs provides many more 
possibilities than the SSP-3's 4-channel I/O structure.

To designate stereo inputs to use for automated background Load:

 

1. In upper-left of the Audio I/O Preferences dialog, click-hold on the 
Load field.

2. From the pop-up menu, select a pair of inputs for use in 
background Load operations.

 

To designate stereo outputs to use for automated background Dump:

 

1. In upper-left of the Audio I/O Preferences dialog, click-hold on the 
Dump field.

2. From the pop-up menu, select a pair of outputs that for background 
Dump operations.
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Desk Modes and Channel Filters

 

The SonicStudio's digital signal processing capacity may be distributed 
and applied in different ways. The number of mixer channels can be 
reduced in order to increase the number of filter sections available and 
provide access to processing functions such as sample rate conversion.

The Desk Mode is selected using the Audio I/O Preferences dialog.

 

16-Channel Desk Mode

 

The default mode provides 16 desk channels (per installed SonicStudio). 
In this mode, one filter is available for each channel strip.

 

8-Channel Desk Mode

 

By selecting 8-Channel Desk in Audio I/O Preferences, you can have up 
to three filters per mixer channel. Note that you can still playback 16 
channels from an EDL by assigning multiple channels to the same 
audition (A1, A2, etc.) channel. These will be summed before entering 
the desk.

Some of the input processing options (sample rate conversion, Turbo Bit-
Mapping and Sony Super Bit-Mapping) require that you switch to the 8-
channel desk. If you select one of these functions while in the 16-channel 
desk mode, an alert will appear advising you to change the mode
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Audio I/O Parameters Dialog

 

Audio I/O Preferences lets you control SonicStudio’s bit resolution, 
dither and automatic de-emphasis.

 

Input/Capture Parameters

 

DC Rejection

 

When DC rejection is enabled, the system applies a digital high-pass 
filter to the audio input to eliminate any DC offset that may be present in 
the input signal. You may set the cutoff frequency of this filter. The initial 
default value is 18.0 Hertz.

 

De-Emphasis

 

The world-wide standards for Compact Disc define an optional pre-
emphasis/de-emphasis function to reduce high-frequency noise. If input 
to the system has been subjected to pre-emphasis, it is suggested that 
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you remove the pre-emphasis on input. Otherwise, changes in level of 
equalization may distort the pre-emphasis curve and result in 
degradation of the final output.

You may elect to switch the input de-emphasis off (Never), on (Always), 
to automatically follow the state of the pre-emphasis flag embedded in 
the digital audio bit stream (On Flag Only).

 

Data Bits Precision

 

SonicStudio is capable of recording, editing, and processing digital audio 
at bit resolutions from 8 bits (used for much interactive multimedia and 
for computer games) to 24 bits. The setting in this field determines how 
many bits of data will be accepted and recorded from the digital audio 
input

Note that Data Bits Precision affects the amount of storage required for 
soundfiles. If resolution is set greater than 16 bits, then all data is stored 
in a long-word format that consumes disk storage at twice the rate used 
for lower resolution audio.

 

Dither Parameters

 

Dither is a means of reducing distortion for low level signals by injecting 
a small random signal into the data. On SonicStudio, dither may be 
added at the input or the output, but not at the same time. Dither on 
input and output uses the same parameters.

In general, we recommend that dither be added at the system output, 
rather than on input. Output dithering is applied to all monitor and 
background dump operations, including dumping to CD-R or DDP-
format Exabyte tapes.
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Dither Gain

 

 

 

The amount of dither is variable. A value of “zero” means that dither is 
turned off. A setting of 100% corresponds to 3 dB of dither amplitude, 
one half of the digitized step size, which is the theoretical ideal value. 
Dither Gain can be set as high as 1000% or 9 dB.

 

Turn-Off Delay

 

In general, dither improves the sound of digital audio by greatly 
reducing the perceived distortion for quiet signals. However, the dither 
signal is itself a noise signal, although at a very low level. In periods of 
silence, this noise may be heard, creating an objectionable impression.

SonicStudio automatically senses silence, and turns off the dither after a 
delay to prevent abrupt cutoff. This delay may be set anywhere from a 
thousandth of a second up to several seconds.

 

Type

 

The standard SonicStudio provides two types of dither. With the 
addition of the Turbo Bit Mapping/Sony super Bit Mapping™ option 
(SS-301), three additional types become available. These are described in 
the manual for that software option.

“Flat” dither uses a white spectrum signal that is relatively audible even 
at the low amplitudes normally used. The 2nd Order setting is weighted 
or filtered to reduce the energy in the critical mid frequency band where 
human hearing is most acute. This reduces the perception of the dither 
signal. In general, the 2nd Order setting is preferred.
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User Note for Dither

 

If desired, you may set the parameters of dither in such a way that dither 
is applied only during an audio crossfade or where gain has been 
changed. Audio that is not altered in level will be passed a bit-perfect 
copy of the original.

 

1. Set dither gain to 50%.

2. Make sure that output word length is set to the same value as input 
word length (or the word length of the files on disk).

3. Set the dither to “Flat.” 

 

Do not use Turbo-Bit Mapping or Sony Super Bit-mapping.

 

4. To check, set Turn off Delay to something long. 

5. With all the desk settings normal (pans hard left/right, faders at 0, 
no EQ), play some audio. 

6. Stop, and increase the gain of your monitoring system. 

 

If you hear dither noise after audio stops, then the audio is being 
affected even when there has been no gain change. If you hear 
absolutely nothing, the settings are correct.

This trick works because the amplitude of the dither is < 1 LSB when the 
gain is set to 50%, and the dither signal is always positive. Therefore, 
when there is no round off error (dither not needed), input = output. 
When dither is needed, the signal is properly dithered before truncation.

 

Output Parameters
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Data Bits Precision

 

The Data Bits Precision is set separately for the output, and is 
independent of the precision of the source soundfiles. If you specify an 
output precision that is less than that of the source files, the audio data is 
rounded down and dithered (if output dither is selected) as it is 
transferred to the digital output ports.

 

Default Sampling Rate

 

This determines the sample rate of the system when “self-clocking.” The 
system will automatically self-clock at any time that all audio inputs are 
switched off. Otherwise, audio sample clock is derived from the 
incoming audio signal, as described previously.

 

CP-340 Channel Status Dialog

 

The CP-340 Channel Status window appears when the Function button 
for any audio port is clicked.

The actions of the Channel Status window revolve around the text field 
in the center. This displays a hexadecimal representation of the 192 bits 
(24 bytes) that constitute a valid channel status block, and is known as 
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the “hex” window. Separate “invisible” data buffers represent the 
channel status received from input (rcv) and the status to be used for 
output (xmit).

An additional buffer contains channel data in binary form. This 
information is transferred to the xmit register when you click OK to 
close the window.

The information displayed by the radio buttons and check box 
constitutes yet another “register” of data. The six buttons below the 
“hex” window are concerned with moving data between these various 
buffers.

 

Update button

 

This is used when you have edited the hex display field by typing or 
pasting information. Pressing causes the information in the hex display 
to be transferred to the buttons, and to the binary buffer.

 

Input button

 

Transfers the information in the receive buffer to the hex display, the 
binary buffer, and the buttons. This lets you capture the channel status 
data used by your source device.

 

Reset button

 

Changes the hex display and binary buffer to reflect the state of the 
buttons. This is used when you have been editing the hex display, and 
you want to return it to a normal state.

 

Load button

 

Transfers the binary buffer to the transmit buffer, which SonicStudio 
uses for audio output. This is used when you want to change the output 
channel status without leaving the Channel Status window.

 

Write button

 

Opens a Macintosh file save dialog, and then saves the contents of the 
hex display window.
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Read button

 

Opens a Mac file read dialog, and loads the contents of the file you select 
into the hex display window.

 

To use the Channel Status window:

 

To read Channel Status from audio source:

 

♦

 

Click on the Input button.

 

The complete channel status block (in hexadecimal) form will appear in 
the long text field. The buttons in the upper part of the window change 
state to reflect the settings for format, sample rate, emphasis, and copy 
prohibit.

To set Channel Status for output:

 

1. Define settings for format, sample rate, emphasis, and copy prohibit 
using the buttons and check boxes in the upper part of the screen.

2. Click on the Update button to transfer the edited channel status 
data to be used for output.

 

To save Channel Status settings to disk:

 

1. Click on the Write button

 

This opens a standard Macintosh file-save dialog.

 

2. Assign a name to the current configuration of channel status, and 
click “OK.”

 

To recall Channel Status setting from disk:

 

1. Click on the Read button

2. Select the file to be read using the Macintosh file load dialog, and 
click “OK.” 

 

The channel status will appear in the text field and will be reflected in 
the settings of the buttons and check box.
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Explanation of the Channel Status Bits

 

The Channel Status window provides the means to view the channel 
status information of incoming audio, and set the information to be 
transmitted with audio output. As it happens, most of the information 
defined for channel status is seldom used. The portions that are 
ordinarily used are those that are needed for proper interpretation of 
audio. These are:

 

•

 

Professional vs. Consumer format

 

•

 

Pre-emphasis (on or off)

 

•

 

Sampling rate (44.1, 48, 32)

 

•

 

The variety of consumer format (General, CD, PCM, or DAT)

 

•

 

State of copy-prohibit (on or off) 

 

Status Bits

 

The above items are encoded into specific bits of the channel status 
block. The first bit indicates whether the format is “Professional” (CP-
340 Type I) or “Consumer” (Type II):

 

•

 

Byte 0, bit 0:‘0’Type II (Consumer)

 

•

 

‘1’Type I (Professional)

The selection of Consumer or Professional determines the interpretation 
of the remaining bits.

Professional format (Type I)

 

•

 

Byte 0, bits 2 & 3

 

•

 

‘00’Emphasis off

 

•

 

‘11’Emphasis on

 

•

 

Byte 0, bits 6 & 7

 

•

 

‘01’48 kHz sample rate

 

•

 

‘10’44.1 kHz sample rate

 

•

 

‘11’32 kHz sample rate

Consumer format (Type II)

 

•

 

Byte 0, bit 1

 

•

 

‘0’copy permitted
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•

 

‘1’copy prohibited

 

•

 

Byte 0, bit 3

 

•

 

‘0’Emphasis off

 

•

 

‘1’Emphasis on

 

•

 

Byte 1, bits 0 & 1

 

•

 

‘00’2-channel format

 

•

 

‘01’2-channel PCM encoder/decoder (F1)

 

•

 

‘10’2-channel CD player

 

•

 

‘11’2-channel DAT

 

•

 

Byte 3, bits 0 &1

 

•

 

‘00’44.1 kHz

 

•

 

‘01’48 kHz

 

•

 

‘11’32 kHz

The chart below shows how settings of format, emphasis, and sample 
rate map into the hexadecimal display.

1. Indicates whether the format is Professional or Consumer, and the 
status of pre-emphasis (on or off). If the format is Consumer, it also 
indicates whether copy-prohibit is set.

 

Table 1: 

 

Value Format Emphasis Copy Prohibit

 

 0 Consumer Off Off

 1 Consumer On Off

308000C000.....

Sampling Rate
(Professional format)

Variation of 
consumer format

Sampling Rate
(Consumer format)

1

2

3

7
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2. In the Professional format, indicates the sampling rate. No function in 
Consumer format.

3. The third digit has no function in the Professional format. In 
Consumer format, it indicates one of four possible variations, 
corresponding to different types of hardware.

 

 2 Consumer Off On

 3 Consumer On On

 8 Professional Off NA

 B Professional On NA

 

Table 2: 

 

Value Sampling Rate

 

1 48 kHz

2 44.1 kHz

3 32 kHz

 

Table 3: 

 

Value Format Variation

 

 

 

0 General

4 PCM encoder

8 Compact Disk

C DAT

 

Table 1: 

 

Value Format Emphasis Copy Prohibit
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4. In consumer format, indicates sample rate.

 

Record Channel Preferences Dialog

 

Record Channel Preferences displays a vertical column for each available 
audio input channel. The dialog expands automatically to accommodate 
the number of boards installed in the system.

 

Sound Disk

 

For each audio input channel pair, you can determine which sound disk, 
out of all local or MediaNet remote volumes, will be used to record 
audio. This setting applies to all operations that create soundfiles, 
including archive restore and background signal processing functions.

When you click-hold on the Sound Disk button for a given channel pair, 
an options list pops up. This includes the names of all sound disks that 
are currently mounted and two additional options, “Auto” and “Always 
Ask.”

 

Table 4: 

 

Value Sample Rate

 

0 44,1 kHz

4 48 kHz

C 32 kHz
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If you select “Auto,” the system will automatically select a sound disk to 
receive the new file. The determination of the appropriate disk depends 
on how the file is being recorded.

 

•

 

If the file is recorded from an EDL panel, or recorded from the Record 
Sound File dialog without pre-specifying the length of the file, then 
the system will select the disk with the most space available, to 
ensure that the file will not be cut off.

 

•

 

If the file is “pre-allocated” (that is, the length of the file is known in 
advance), as when produced by background processing, restore of 
archive or when the length of a file is specified in advance in the 
Record Sound File dialog, the system will select the sound disk with 
the least amount of space that will satisfy the amount of time 
required. This ensures efficient use of disk space.

 

Input Source

 

This applies only to recording from the Record Sound File dialog. You 
may switch any line input on or off. Note that the “M” selections shown 
in gray are left from previous versions and are not available.

 

Record /Safe

 

Applies to recording from the Record Sound File dialog only. You may 
elect to place any enabled input in record arm or record safe.

 

Audio I/O Prefs…

 

For convenience, this button brings you directly to the Audio I/O 
Preferences dialog

 

Save As Default

 

Causes the current setting of Record Channel Preferences to be used 
every time the system starts up.
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Record Path Preferences Dialog

 

This dialog determines how new soundfiles will be named, and the 
folders in which they will be stored. This “default” name/path applies 
to all files recorded from EDL panels. When recording from the Record 
Sound File dialog, the default name and path is inserted initially, but the 
user can easily change the name prior to recording.

 

Folder Name

 

Specifies the name of the “high level” folder that encloses the actual 
recording on the MOFS disk.

 

Sound Name

 

This is the name of the actual recording. A 4-digit numeric tag is added 
by the system automatically (see below).

 

Next Take #

 

The number here defines the initial 4-digit “take” number.

 

Auto Increment checkbox

 

When this checkbox is selected, the system will automatically increment 
the “take number” for each successive recording.
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CAUTION  Recording from an EDL panel will not work if this checkbox 
is not selected!

Use Project Folders 

When a Project is open, the default path defined in this dialog is 
overridden. The soundfile is still named according to the “Sound Folder 
Name,” but the single Group Folder is replaced by the three folder levels 
(Customer, Project, Title) defined when you create the Project. This 
checkbox is inactive if no Project is open.

System Preferences Dialog

Reaction Time

When placing marks into an EDL during playback, allowance needs to 
be made for human reaction time as well the time required by the 
computer for processing of the keystroke or menu command.

Input Delay

This is the delay between input and output straight through 
SonicStudio, owing to buffering for digital I/O. The value is expressed 
in samples, with a range of 64 to 384.
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Desk Delay

 

The dynamics processing functions provided with the Mixing Desk 
option (SS-201) use “look-ahead” to eliminate delay between input level 
changes and changes in gain. The Desk Delay parameter defines the 
delay used in samples. When monitoring audio straight through the 
system, the Desk Delay is added to the Input Delay to derive the total 
throughput delay.

 

System Time Display

 

This determines the format of time displays and calculations throughout 
the system (anywhere that the selection of “System” is used). If you need 
to change the time displays, it should be done here rather than in the 
individual area, so that consistency of time format is maintained. 
Synchronization problems could otherwise result from mismatches in 
time format.

 

SCS-1000 

 

When this box is selected, the system will search on the serial (machine 
control) port for an SCS-series hardware controller. If none is found, the 
SCS functions are not enabled.

 

Always Sync. Sound Disk After Record 

 

The internal directories for soundfiles are maintained by the system. 
When this box is selected (the default), the directories are updated as 
soon as a recording is completed. This ensures that the directories are 
always consistent.

The price is a small delay at the end of each recording. When doing 
many recordings in succession, it may be desirable to switch this off so 
that recording can be started as quickly as possible. The system will 
periodically update the directories, but not on every record.
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Enable SCSI Error Checking 

 

With this box selected, the system automatically examines its SCSI-bus 
transactions for errors, which are printed to the Status Window (see the 
Window Reference chapter). The checkbox is provided to disable this 
function in case the error checking is found to be incompatible with any 
model drive. As of this writing, this situation has never been 
encountered.

 

EDL Preferences Dialog

 

The EDL Preferences dialog provides tools for the precise control of all 
editing functions. EDL Preferences includes many individual items. 
These are grouped into several groups, selected by radio buttons along 
the left side of the dialog.

When you open the EDL Preference dialog, the EDL Name field shows 
the current active EDL. If there are no EDLs open, then the dialog affects 
the default settings that are applied when a new EDL is created.

 

Show Defaults

 

Changes all fields to show the default settings currently installed in the 
system.

 

Save As New Defaults

 

Replaces the current default EDL preferences with the values in the 
dialog.

 

Read Template

 

Opens standard file select dialog to select a preferences file. The values 
in the selected template file then appear in the EDL Preferences dialog 
fields.
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Write Template

 

Store the current settings in EDL Preferences into a template file that 
may be read using the Read Template function.

 

General Settings

 

Sample Rate

 

The sample rate value assigned to an EDL is used by the system to 
calculate the location in time of individual waveform samples. It is very 
important that the sample rate of the EDL match the sample rates of the 
soundfile used in it. The Sample Rate field in EDL Preferences provides 
a pop-up menu to select the sample rate.
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In the default setting, Auto, the system assigns the sample rate value by 
the sample rate in use at the time the EDL is created. In most cases this 
will be the right value, but if it somehow happens that the EDL rate is 
set incorrectly, use EDL Preferences to select the correct setting.

 

Display Time

 

This determines the time scale shown in the EDL panels, with choices of 
various forms of SMPTE time code, film foot/frame notation, raw 
sample count, or seconds. Ordinarily, the setting of System will be 
appropriate and will guarantee that the EDL display is consistent with 
time displays throughout the system.

 

Open Sound File

 

There are three choices for determining which panel a newly opened 
soundfile will appear in.

In the initial default, Source Panels, soundfile automatically open into 
the panels assigned to the Source edit group. If you select Destination 
Panels, soundfiles will open into the Destination panel group.

If you select Empty Panels, then each soundfile you open will appear in 
the next panel, or group of panels, that do not already contain sound. 
Each time you open a file, the system automatically creates new empty 
tracks. You cannot run out unless you exceed the system limit of 144 
panels in an EDL.

 

Emphasis

 

Each EDL includes a definition of CD pre-emphasis on or off. At present, 
however, this flag is not used.
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Track Sorting

 

When you change the number of a panel in an EDL in order to view a 
different track, the panels displayed are automatically reordered to allow 
for the changed panel.
´

If you select Use Group (the default setting), then panels will be 
reordered so as to keep panels that are in the same sync group (letter-
name groups) together. If you elect Ignore Group, then panels are 
rearranged minimally, without regard to previous grouping. Depending 
on the type of editing you are doing (groups of stereo or multi-channel 
files vs. many monaural files) one or the other setting may serve your 
needs better.

 

Override warning messages on open

 

By default, SonicStudio will warn you when you open a soundfile into 
an EDL whose sample rate setting (see above) does not match that of the 
soundfile. Warnings are also posted if you have selected the “Open 
soundfile without offset” (see below) option and open a file into a panel 
that already contains sound.

These warnings protect you against creating situations that could 
seriously affect your editing, but in some cases the warnings may just 
get in the way and slow you down when you are doing something you 
know that you want to do. In that case, disabling these warnings will 
speed your work. It is highly recommended, however, that you re-enable 
the warnings once you work is completed.

 

Open SoundFiles without offset

 

By default, newly opened soundfiles are placed in the panel so that:

 

•

 

The left edge of the file is aligned at that file’s time stamp, or

 

•

 

If the file has no time stamp, successively opened files are placed one 
after another in the target panel.



SonicStudio Version 5.2 3-41

Dialog Reference

 

If you elect “Open soundfiles without offset,” then these rules are 
overridden. New files will always open at zero time, and successively 
opened files will overwrite the previous files.

 

Display Settings

 

Number of Panels

 

Determines the number of panels that will be shown on-screen. As the 
number of panels shown increase, the vertical size of the panels is 
reduced automatically to fit more on-screen. If the number of panels to 
be display exceeds that number that can fit in the display window, Mac-
standard scroll bars are provided.

If you change the number of panels for an EDL that is already open, you 
must save, close and re-open the EDL to see the new # of panels.

 

Move Forward/Backward By (%)

 

When you use the Move Forward and Move Backward commands in the 
View menu, the view of the currently selected panel or group will shift 
such that the previous view overlaps with the new view. The amount of 
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overlap is determined by the Move Forward/Backward By (%) setting. A 
setting of 100% results in no overlap (on a Move Forward, for example, 
the previous right edge become the left edge of the new view).

 

Zoom In/Out By (%)

 

When using the Zoom In and Zoom Out commands in the View menu, 
the amount of zoom from the current view is determined by this setting.

 

Zoom Times (seconds) Before/After Edit Point

 

When using the commands Zoom Around In Point or Zoom Around Out 
Point in the View menu, this setting determines how much time on 
either side of the edit point is shown.

 

Text Font Size

 

When editing in the text view mode, you may elect to display 
information using either a 9-point or 12-point font. The smaller 9-point 
font will allow more information to be fit into the window, but the larger 
12-point font may be easier to read, depending on your display monitor.

 

Show Times

 

When using smaller panels sizes, the boxes at lower left and right of 
each panel that show the positions of the left and right Gates and the In 
and Out points may obscure portions of the waveform. As the same 
information is available in the tool bar of the EDL (for current selected 
panel), you may elect not to show these boxes.

 

Show Edits/Fades

 

Audio edits are shown in the waveform and Bar display modes as 
vertical lines that expand to boxes if you zoom in close to show where 
the edits are placed. When you zoom out to view a section of audio that 
has many edits, individual lines may blur into a solid mass. For clarity in 
a situation such as this, you may elect to disable the display of the edits.
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Show Marks

 

You may disable the display of editing marks (Segment Start/End, etc.). 
In most cases, this would be a temporary setting.

 

Show Interpolations

 

Applies to Manual Declicking (NN-101) and Production Declicking (NN-
103) options. Ordinarily, portions of waveform that have been inserted to 
replace a click are shown with a red bar over the site of the former click. 
If desired, you may elect to disable the display of these bars.

 

No Background

 

By default, waveform and Bar displays are drawn with a gray 
background. If this is found distracting, you may elect to disable it.

 

Amplitude Lock

 

SonicStudios waveform display automatically scaled so that no matter 
what the level of audio within the boundaries of the panel, the vertical 
scale will be completely filled. This is a powerful feature that lets you 
view audio at any level with perfect detail and resolution. However, at 
times it may be confusing, as each panel is scaled independently. If you 
select Amplitude Lock, the same scaling will be applied to all panels that 
are in the same sync (letter-name) group.
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Editing Preferences

 

Undo Edit Depth

 

When editing, you may use the Undo Edit command to step back 
through your last number of edit moves, undoing each in turn and 
returning the system to its prior state. The Undo Edit Depth setting 
determines how many levels you can move back. The default setting is 
25, with a maximum of 100.

 

Editing Model

 

When a new EDL is created, the editing panels in the EDL are grouped 
into sync (letter-name) and edit (Source/Destination) groups. The setting 
of Editing Model determines how many panels are placed in each group. 
A setting of 2 (the default) is ideal for stereo editing and mastering. 
Multi-track mono applications such as sound effects assembly might use 
an editing model of 1, while editing of multi-channel files might use a 
larger number.
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Move Source When Syncing

 

When using the commands in the Synchronize submenu of the Edit 
menu, the system by default will align the Source and Destination edit 
groups by moving the Source group. If you wish, you may switch this so 
that the Destination group is moved while the Source group remains in 
place.

 

Enable Segment Editing

 

If you desire, you may disable all of the segment-oriented functions 
(such as segment select, text view editing, segment drag, and so on) by 
de-selecting this checkbox. This is provided principally for consistency 
with early versions ofSonicStudio, which did not have these features.

 

Reel Rock Preferences

 

The Reel-Rock function is controlled by six parameters. Smoothing 
Threshold, Minimum Smoothing, and Maximum Smoothing apply only 
to Jog mode, while Low-Speed Gain and Maximum Speed apply 
primarily to Shuttle.
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Smoothing Threshold

 

Range — 0 to 60. Smoothing is used to compensate for the discontinuous 
nature of updating and reporting the mouse location. As you move the 
mouse, its position is periodically detected and sent to SonicStudio. You 
can move the mouse and cursor faster than its position can be reported. 
This setting controls the break point (threshold) between Minimum 
Smoothing and Maximum Smoothing regions.

 

Minimum Smoothing

 

Range 0 to 0.99 (dimensionless). This setting can be thought of as low-
speed smoothing. The Minimum Smoothing setting is used to average 
the incoming location values for play speeds from stop to the Smoothing 
Threshold. At low play speeds, more smoothing is needed than at high 
speeds. A value of 0.15 is nominal.

 

Maximum Smoothing

 

Range — 0 to 0.99 (dimensionless). This setting can be thought of as 
normal-speed smoothing. The Maximum Smoothing setting is used to 
average the incoming location values for play speeds from the 
Smoothing Threshold to Maximum Speed. A value of 0.9 is nominal.

 

Rate Multiplier

 

Range — 5 to 25 (dimensionless). The Rate Multiplier represents 
conversion from number of screen pixels to feet per second. The mouse 
position is normalized (converted) to a value between 0 and 1. The 
normalized value is then multiplied by the Rate Multiplier value.

A setting of 25 is very unstable, potentially causing SonicStudio to play 
backwards even though the mouse is in the right half of the panel. A 
setting of 5 produces very sluggish response to mouse movements.

 

Low-speed Gain (dB)

 

Range — 0 to 12.042 dB. This setting controls the gain at zero play speed 
or stop. SonicStudio will output a DC value which is the sample value at 
the play pointer times the Low–Speed Gain value. As play speed 
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increases from stop, the gain decreases linearly, reaching 1 when the play 
speed is at the Smoothing Threshold. High values of Low–speed Gain 
can produce saturation with large amplitude samples.

 

Maximum Speed

 

Range — 0.5 to 1.0 playback, real time. Maximum Speed is the rate of 
play reached when the mouse cursor is at the right edge of the 
Macintosh screen while in Shuttle mode. The legal values for this 
parameter are from 0 to 1. Note that values of less than 0.5 results in 
extremely slow play. A value of 0 means that the scrub does not take 
effect at all.

The diagram below illustrates the interplay between Smoothing 
Threshold, Max/Min Smoothing, Low–speed Gain and play speed.

The five curves show the effect of Low–speed Gain settings from 0 to 12 
dB in 3 dB increments. The vertical dotted line indicates an arbitrary 
Smoothing Threshold setting. 

As the setting is changed, the threshold would shift left or right on the 
graph.
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Determines the default mode for Reel-Rock. The initial default is Shuttle, 
in which the scrub acts like a low-speed play. In jog mode, play 
corresponds to 

 

motion

 

 of the mouse, rather than position, and is similar 
to rocking tape reels on an analog tape transport.

Switches the Low-speed Gain on or off. With Reel-Rock Gain disabled, 
the gain remains flat at all scrub rates.

 

EDL Only Jog 

 

When equipped with the SS-516 Machine Control option, SonicStudio 
has the capability of performing Reel-Rock while an external transport is 
slaved to it. The requirements of control in this circumstance are quite 
different from those used for control of the Sonic by itself, and lead to 
different “feel” that may interfere with locating points precisely. The 
option of “EDL only Jog” allows the system to behave optimally in all 
cases.

The default state of the Reel-Rock Preferences is “EDL only Jog” OFF. If 
there is no external device slaved to the system, the user should set this 
check-box ON for best results.
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Audition Preferences

 

Audition Time Before/After In Point

 

When you use the commands Play to In Point or Play From In Point in 
the Play menu, this setting determines how long before or after the In 
point will play.

 

Audition Time Before/After Out

 

As with the previous item, this setting determines how long the system 
will play before or after the Out point when the Play menu commands 
Play To Out Point or Play From Out Point are used.

 

Audition Time Before/After Edit

 

When auditioning from the Edit Fade window, this setting determines 
how long it will play before and after the edit you are viewing.
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Background Processing During Audition checkbox

 

Applies if you are using a NoNOISE or FX processing card to do 
background processing. By default, background processing pauses when 
you play audio. If you wish, you may set this checkbox so that 
processing will continue. The trade-off is system responsiveness. If you 
continues to process during play, then response time to play and other 
commands is slower. If you are going to do a long playback for transfer 
or other purposes at the same time that a background job is in progress, 
you may wish to select this function so that the background process can 
proceed.

 

Move Forward During Audition 

 

If you select this checkbox, the display view in the EDL panel in 
waveform or Bar mode will move forward automatically when the play 
cursor reaches the right edge of the panel.

 

Edit Fade Preferences Dialog

 

Edit Fade Preferences sets default values that are used in the Edit Fade 
window.
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Lock Sound In Place
Auto Zoom
Ripple Until Black 

 

These checkboxes determine the initial state of the checkboxes of the 
same names in the Edit Fade window.

 

Zoom Factor

 

When the Edit Fade window opens, and when a change in the fade 
causes an automatic zoom, the system examines the length of the fade 
and adjusts the duration of the view so that the fade is shown at an 
appropriate size. The Zoom Factor is a percentage that determines how 
the fade is fit in the window. The larger the Zoom Factor, the more of the 
panel will be occupied by the fade. If Zoom Factor is set to 100%, then 
the fade shown will occupy the entire panel from left edge to right edge. 
If Zoom Factor is set to 5%, then the fade itself will be shown as a small 
area centered in the Edit Fade window panel. The default value for 
Zoom Factor is 33%.

 

Nudge Values 1, 2, and 3

 

In the lower left portion of the Edit Fade window there is a pair of left-
right arrows used to nudge In and Out points, and their associated radio 
buttons which select a time increment for each nudge. The Nudge Values 
fields in Edit Fade Preferences assign the values that each of the radio 
buttons will represent. You could, for example, set the first nudge value 
to one subframe, the second to one frame, and the third to one second. 
The values set in the Preferences dialog are displayed next the to radio 
buttons in the Edit Fade window.

 

Edit Default Fade

 

When performing edits, SonicStudio uses four default fades

 

•

 

Fade from Black - for fading sound in from silence

 

•

 

Fade To Black - for fading sound down into silence
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•

 

In Cross-fade - placed where an Insert edit cuts into a previously 
placed sound

 

•

 

Out Cross-fade - placed where the tail of an inserted segment fades 
back to a previously placed section of audio.

To defined the setting used for each of the defaults, select one of the four 
default fades using the pull-down menu above the Edit Default Fade 
button, then click on the Edit Default Fade button. This opens an Edit 
Fade window with the current default settings for the selected default 
fade.

 

Freq. Analysis Preferences Dialog

 

Frequency Analysis Preferences controls the display and function 
parameters of the Frequency Analysis panel display mode. The 
parameters in this window are divided into several blocks.
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Transform Type

 

The default setting for the Transform Type is DFT for Discrete Fourier 
Transform. This is the familiar type of analysis, in which the results are 
expressed in a frequency vs. amplitude format.

The Autocorrelation analysis is the inverse of the DFT. In this form, the 
results are expressed in terms of the period of the component signals 
rather than frequency. The full scale in which the periods are expressed 
equals the length of the analyzed section (see below).

The Cepstrum analysis is a more specialized form of signal analysis that 
is sometimes used for speech work.

 

Padding Technique and Transform Size

 

Frequency analysis works best (fastest) when analyzing a group of 
samples whose number is a power of 2. The Transform Size provides a 
selection of powers of two for use. The largest of these, 16384, 
corresponds to about a third of a second at a sample rate of 48 kHz.

The user may select one of these values, but it is more usual to choose 
the option EXACT and then specify a method of padding. The system 
looks at the area marked by the Gates, and then adjusts that to the 
closest power of 2 (unless the option of No Padding is selected).

If Pad with Zeros is selected, the system will add zeros to the end of the 
gated area to bring it up to the nearest greater power of 2 in size. If the 
user gates an area that matches a major pitch period of the signal 
viewed, this results in an analysis that is somewhat easier to interpret 
accurately.

The options to Grab More Data or Take Less Data cause the system to 
alter the area of the waveform to fit the nearest power of 2 up or down. 
This is much the same as selecting a fixed Transform Size, and obviates 
the benefits of selecting the analysis area with an eye to the signal’s 
period.
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The option of No Padding causes the analysis algorithm to run much 
more slowly, but does not produce a correspondingly more accurate 
result.

 

Windowing Function

 

In order to produce an accurate analysis on a finite number of data 
points, it is necessary to apply a 

 

windowing

 

 function to compensate for 
the effects of transition at each end of the analysis period.

SonicStudio provides three types of window that are commonly used for 
DSP functions. These three types, Hamming, Hanning, and Kaiser-
Bessel, are optimized for different aspects of the analysis. DSP 
authorities continue to debate the relative merits of each window.

For SonicStudio users, it is much less important which window is chosen 
than that some window be used. If the analysis is taken with None 
selected under Window function, the resulting analysis will continue 
numerous spurious frequency components.

More information on windowing and analysis in general may be 
obtained from the references listed at the end of this appendix.

 

Kaiser-Bessel Filter Parameters

 

This is a single parameter, with dependent parameters, that applies only 
to the Kaiser-Bessel type. It defines a window function that applies to the 
analysis.
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Nudge Preferences Dialog

 

This dialog applies to the Nudge commands in the Edit menu (Nudge 
Segment Left and Nudge Segment Right), and in the Mark menu (Nudge 
Left In Point, Out Point, Both Points and Nudge Right with the same 
options).

The Nudge Factor field specifies that amount of time that will be applied 
each time a “nudge” command is performed. You may enter any value 
you like in this field, but in most instances smaller values, such as a 
single frame, will be most useful.

The Always Audition To Edit Point and Always Audition From Edit 
Point apply both to nudging of segments and to nudging of edit points. 
However, they will be found most useful when using the nudge 
commands to adjust the position of an edit (In or Out) point.

 

External Devices Dialog

 

Requires software option Machine Control SS-516
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External Devices displays the name and time code clocking type of all 
devices connected to Sonic SCSI ports. The use of this dialog is described 
in the manual for the Machine Control Option SS-516.

 

Ports A, B, C, and D

 

The External Devices supports four different serial ports that can be 
used. In a SonicStudio configured using SSP-3 hardware, only the first 
two ports, A and B, can be used. You can connect a single serial-
controlled transport to each port.

 

Device

 

When using machine control in conjunction with the Project Manager for 
automated background load and dump, each machine can be defined as 
either Load or Dump device. If only a single machine is available, it may 
be defined as serving both purposes.

When using the Transport Panel to operate external devices, this 
terminology is also used, so that the Transport Panel’s Master and Slave 
sections have selections for Load and Dump.

 

Type

 

Click on the Type button next to the selected Device to engage a menu of 
several devices that are commonly used in professional applications.
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It is not feasible to provide a separate selection for every model of device 
that might be connected to the system. The majority of devices on the 
market with serial control capability adhere to the protocol used by Sony 
Corporation in their professional video and digital audio equipment.

The “DMR-4000” selection matches this implementation for the special 
transport that Sony provides for use with their PCM-1630 digital audio 
mastering system. This is exactly the same as Sony’s popular BVU-800 
video transport.

 

TC

 

Most devices use the 9-pin serial link to carry time code as well as 
control commands. When using a device that does not communicate 
time code in this way, it is necessary to connect a time code (LTC) output 
from the device to the system’s time code reader, then to select “LTC” as 
the time code source by clicking on the TC button for the appropriate 
serial port. Note that activated serial ports default to the “9-pin” setting 
unless “LTC” is chosen.

 

Rate

 

For virtually all SonicStudio applications, it is best to set the system’s 
clocking rate with the System preferences dialog. In this case, all external 
devices should then be set to run at the default “System” speed setting. 
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In the event that a clocking rate different from that of SonicStudio is 
required, click on the “Rate” button for that device’s serial port then 
select the desired clock rate.

 

Reference/Offset

 

The Reference window allows the user to alter the playback offset for an 
external device. If, for example, an EDL begins at 00:00:00:00 but the 
corresponding videotape begins at 02:00:00:00, the user can set an offset 
of 02:00:00:00. Thus when the EDL is at 01:03:53:18, the slaved machine 
would be at 03:03:53:18. Change the defaults by clicking on the 
appropriate number then either typing or click-dragging the desired 
offset. The EDL offset can also be adjusted with the EDL Reference 
window.

Click at the top of this column, on the word “Reference” to switch the 
display from “Reference” to “Offset”. The offset is the inverse of the 
Reference time. If the References is 01:00:00:00, then the Offset is -
01:00:00:00.
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EDL Reference

 

You may also specify an offset for the EDL. This operates in the reverse 
direction from the machine offsets.

 

Show Setup

 

Clicking on the “Show Setup” button brings up a menu which allows the 
user to access a range of display options. The Pre Roll, 9-pin offset and 
Edit Advance settings of the Dump and Load machines can be seen and 
adjusted by typing or click-dragging the desired number.

“Background Setup” in the “Show Setup” menu provides choices for 
machine control recording. In “Insert” mode, the user can select video or 
six channels of audio for punch-in. In “Assemble” mode, one video and 
two audio channels are utilized for punch-in.
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MIDI Preferences Dialog

 

The MIDI Preferences dialog box determines the MIDI data ports, MIDI 
time code port, and MIDI map for external controllers. This dialog box 
can be accessed only if OMS or the MIDI Manager has been installed.

The MIDI Routing section has options you can use to assign the ports 
used to send and recieve MIDI information, such as controller messages 
and system exclusive data. Use the MIDI Controller Map option to 
match the particular device you are using as an external mioxing 
controller.

If only MIDI Manager is present, your choices for this dialog will be 
MIDI Manager Port A or MIDI Manager Port B. If OMS is present, the 
ports you have specified in your OMS MIDI Setup will appear in the 
MIDI routing menu selections. Sonic Solutions recommends that you use 
Opcode’s OMS (Open Music System™) for routing MIDI data. OMS has 
become the MacOS standard for interfacing MIDI hardware and 
software and replaces the Apple MIDI Manager as the primary software 
interface for MIDI data between SonicStudio and the Macintosh serial 
ports.
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MIDI Routing Section

 

Choose a port selection from the list for 

 

Receive MIDI Data on

 

 to 
specify a data port for incoming MIDI messages.

Choose a port selection from the list for 

 

Send MIDI Data on

 

 to specify a 
data port for outgoing MIDI messages.

Use the 

 

Controller Map

 

 option to choose the appropriate controller map 
for your MIDI controller. A controller map is a configuration file that 
maps MIDI controller messages to SonicStudio functions and vice-versa, 
allowing a controller to work with SonicStudio without additional setup 
procedures. Currently supported controller maps include General 
Volume and Pan, JLCooper CS-10, P+G MM16, and the P+G DC16. More 
about each of these devices, as well as OMS, can be found in the 

 

Installation and Maintenance Manual

 

.

 

MIDI Time Code Section

 

Under the MIDI Time Code section, you may assign Sonic’s time code 
generator to a MIDI port, generating MTC (MIDI Time Code). MIDI 
Time code can only be routed via MIDI Manager at this time, as OMS is 
not yet supported for MTC. If you have both OMS and MIDI Manager 
installed on your Macintosh, OMS ports will appear in the MIDI Routing 
section and MIDI Manager ports will appear in the MIDI Time Code 
section.

Choose MIDI Manger Port A or MIDI Manager Port B to send MIDI 
Time Code to your MIDI devices via MIDI Manager.

To turn on Time Code Generation, or to set your Time Code Preferences, 
click the button marked

 

 Time Code Preferences 

 

in the MIDI Time Code 
section.

You may also specify an offset to be added to the MIDI time code sent to 
the MIDI port. This offset will be in addition to the offset specified in the 
Time Code Generator section of the Time Code Read/Write window.
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PQ Burst Preferences Dialog

 

(Requires PQ Basic option SS-524 or Expanded PQ Code Editing option 
SS-525)

 

 

 

Details on CD mastering and the use of PQ codes is provided in the 
manuals for these options.

 

Time Code Reader/Generator Preferences Dialog Box

 

Time Code Reader/Generator Preferences controls SonicStudio’s reading 
and writing of time code. There are three principle sections:
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•

 

Port assignment

 

•

 

Time code reader preference

 

•

 

Time code generator preference

 

Port Assignment

 

This section is used to switch time code reading and generation on and 
off. At any time that you are not actually using the systems time code 
reading or generating capacities, you should switch them off, as they 
consume processing resources that may be required for other functions.

Previous versions of SonicStudio required that different serial ports be 
selected for reading and for writing. This does not apply for 
SonicStudio 16•24. Select Serial 2 for 

 

both

 

 time code read and for time 
code write.

 

Time Code Reader Preferences

Use Serial 2 for
TC read and write
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The variable parameters in the Time Code Reader Preferences section 
principally apply when slaving an EDL to incoming time code, as set at 
the Transport Panel.

 

Reader Time Offset

 

This is an offset value added to incoming time code. If your EDL, for 
example, begins at time zero, but the time code from your external 
transport starts at 1 hour, you would specify a Reader Time Offset of 
minus one hour, so that the start point of time code on tape would 
trigger playback from the beginning of the EDL. Alternatively, you could 
shift everything in your EDL to start at 1 hour.

 

Play Trigger

 

The earliest time that will be recognized for driving playback of your 
EDL.

 

Ramp Up time

 

This provides a compensation for latency in SonicStudio’s response to an 
audition command.

 

Play to T.C. Preroll

 

When a mechanical transport starts up, there is generally some period of 
time before the transport comes up to full speed. Time code read during 
this period is suspect at best. Preroll defines the length of good time code 
required to be recognized for play triggering.

 

Set Frame Rate

 

Defines the format of incoming time code. Ordinarily this will be the 
same as the System rate.

 

Time Stamp Delay

 

Applies to recording with time stamp, as shown in the Record Sound 
File dialog. As it is common to start a recording before audio actually 
begins, the time stamp is taken after actual recording begins. The 
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amount of time already recorded is subtracted from the time stamp 
taken, so that a value for the time stamp of the very first sample is 
derived. The Time Stamp Delay defines the length of time between start 
of recording and taking of the time stamp.

 

Time Stamp While Coasting

 

In cases of intermittent time code, the system will interpolate or 
“freewheel” for a defined length of time. Because the time stamp of a 
recording is critical, it may sometimes be dangerous to rely on an 
interpolated value.

 

T.C. Coast Time

 

The length of time that the system will freewheel, interrupted time code. 
Note that interpolated time code is highly reliable provided that the 
incoming time code and SonicStudio’s sample clock are resolved to a 
common reference.

 

Trigger Play Once

 

With this option, play to time code will trigger exactly once.

 

Auto Resync After Play Start

 

If time code is being actively shuttled, auto resync may be useful. If this 
is not

 

 

 

selected, the system will continue to play even as the deck is 
relocated to a different point.
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Time Code Generator Preferences

 

Time Source

 

SonicStudio’s time code generator function has three modes of 
operation.

 

•

 

In Free Run mode, the generator will run continuously, regardless of 
what else is being done with the system.

 

•

 

In EDL Audition mode, the generator will run in parallel with 
playback of the EDL. This is extremely useful for lay back, or for 
triggering of external devices such as MIDI sequencers or event 
controllers.

 

•

 

Incoming Time Code mode will generate code that parallels code 
read from the reader port. Note that SonicStudio is not recommended 
for use as a time code regenerator.

 

Continuous Run 

 

This applies in EDL Audition and Incoming Time Code modes. If this 
box is selected, time code generation will continue after playback of the 
EDL stops, or incoming time code is no longer seen
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Time Offset

 

This is a value added to the start time (for Free Run mode), or to the 
EDL time (EDL Audition mode) or incoming time code.

 

Generated Time Code Format

 

This defines the type and rate of time code output from the system. This 
can be defined separately from the system time, if you need it to be.

 

Utility Dialogs

CD Compare Dialog

 

Requires two Sonic CD-ROM Readers (SS-422) attached to the Sonic 
SCSI bus. This dialog lets you compare the contents of two CD-ROMs.

 

Board

 

In a system with multiple SSP cards, you will need to define which 
board the two ROM drives are connected to. You may only compare data 
between devices connected to the same card.

 

Device 1/ Device 2

 

Use these two pull-down menus to select the SCSI IDs of the two ROM 
drives.
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Temp disk space

 

The compare operation uses a temporary disk buffer to hold data for 
comparison. This field lets you define the size of that buffer.

 

SCSI Copy Dialog

 

This dialog appears when you select the command SCSI Copy from the 
Utilities submenu.

With this dialog, you may copy the contents of one SCSI Device on 
SonicStudio SCSI chain to another device. This produces an exact bit-for-
bit copy. The most common use of SCSI copy is to produce CD-ROMs 
from any type of computer hard disk, using the START Labs™ CD 
Printer (CD-200)

Devices containing data to be copied or imaged as CD-ROM data must 
be connected to SonicStudio SCSI bus. When a disk containing a non-
Sonic (foreign) file system disk is connected to the SSP-3 SCSI bus, an 
advisory message appears on start-up.

When connecting and disconnecting disk drives, be careful to maintain 
proper termination at the end of the chain, and make sure that all 
devices on the bus are assigned to different SCSI ID numbers.
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Source and Destination devices for SCSI Copy operations are designated 
by SCSI ID numbers. It is important to note the numbers for the source 
device (8mm tape or non-Sonic hard disk) as well as the number 
assigned to the CD Printer or CD Writer so they can be selected from the 
dialog.

With the data source device connected and mounted, the procedure is to 
copy a direct image of all or part of the source devices data onto a 
Sonic/START lab CD Printer or CD Writer that is also connected on the 
SCSI bus.

To copy a data image from 8mm tape or non-Sonic source disk: 

 

1. Select Utilities from the File Menu

2. From the pull-right submenu, select SCSI Copy.

 

This opens the SCSI Copy dialog.

The SCSI Copy dialog lists the SSP/SCSI board (for multi-track/
multi-board SonicStudio systems) on which the copy operation will 
be performed. This field defaults to the first board in the system. Note 
that it is not possible to copy from one board’s SCSI bus to another’s.

 

3. If necessary, use the Board popup menu to specify which SSP board 
will be used.

 

SCSI Copy includes fields to designate the Source and Destination for 
a copy operation according to SCSI ID number. These are equipped 
with pop-up menus that list SCSI ID from 1 to 7.

Only those devices appropriate for the operation will be available in 
the Source and Destination menus. Unavailable SCSI ID numbers 
appear in gray.

 

4. Specify a SCSI ID for the source device.

5. Specify a SCSI ID for the destination device.

 

After SCSI IDs are selected, the Get Source Info button becomes 
highlighted. Before the copy operation can proceed, it is necessary for 
the system to characterize the amount of data that must be 
transferred.
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6. Click on the Get Source Info button. 

 

SonicStudio will attempt to identify the type and size of the Source 
file system.

If the source device is a labeled, standard-format Exabyte tape, 
SonicStudio reads the tape’s End Of File labels to determine the 
number of records on the tape and, hence, the amount of data to be 
copied.

If the source device is a disk in a known foreign file system format, 
SonicStudio extracts the file system size from the disk itself. This is 
usually larger than the amount of space required for the actual data, 
since it contains free data blocks that have not been allocated.

 

7. Click on Copy.

 

SonicStudio then starts the copy operation.

At this point the SCSI Copy Dialog is dismissed and the operation 
begins. Its progress may be monitored or aborted by bringing up the 
Background Manager window.

 

Editing Dialogs

Adjust Gain Dialog

 

The Adjust Gain dialog appears when you select the command Adjust 
Gain from the Edit menu, or when you double-click on the Gain field of 
a segment in the text view display mode. This dialog provides a range of 
choices in resetting the gain of a selected segment or segments.
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Use the window at the top of the dialog to enter a specific gain value, 
positive or negative. The range of gain available goes from minus 
infinity to +24 dB. You may also use the up and down arrows below the 
window to nudge gain values in decibels or 10ths of decibels.

Gain may be set in either absolute or in relative terms. An Absolute gain 
value is applied directly to the selected segment or group of segments. 
Any previous gain adjustments are overwritten.

If you select the Relative option, then the gain of the selected segment or 
segments is adjusted up or down from the current gain setting. (If there 
have been no previous adjustments, then Relative and Absolute have the 
same effect.)
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The distinction between Absolute and Relative gain is particularly 
important when changing the gain of a group of segments, as shown 
above. The top panel shows a pair of segments. The gain of the second 
segment has been adjusted to be 10 dB lower than that of the first. In the 
second panel, an Absolute gain of +24 dB has been applied to both 
segments. In the third panel, the same gain was applied in Relative 
mode. The 10 decibel level difference between segments has been 
preserved.

If the relative levels between segments have been adjusted, then you will 
probably want to use the Relative option. This will shift the gain of each 
segment by the specified amount, and preserve the relative balance, 
whereas the Absolute setting would simply set all of the segments to the 
same gain value and destroy the relative balance

 

Normalize Level

 

The third option, Normalize, is actually an automatic gain setting. If you 
select this option, then you do not enter a value into the gain window at 
top. The system will scan the selected segments, determine the highest 
instantaneous level, and apply a gain value such that the highest peak 
will fall just below digital clipping. This provides an efficient way of 
optimizing signal level and signal-to-noise before final transfer.

 

Phase Invert

 

Phase Invert is an option that may be applied in conjunction with any of 
the three gain adjust mode options. If Phase Invert is selected, the 
absolute polarity of each sample is reversed at the same time that the 
defined gain adjustment is performed.
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Specify Offset Dialog

 

The Edit menu commands Offset Left Edge or Sync Mark to 
Wherever…bring up the Specify Offset dialog.

Type or click drag to enter the desired time value.

 

Mark Dialogs

Edit Time Dialog

 

Selecting the command Move In Point… or Move Out Point… from the 
Mark menu brings up this dialog. You then enter the time value at which 
you want to place the In or Out points and click OK. The specified edit 
point (In or Out) is moved to the specified location.

You may also bring up this dialog by double clicking at the position of 
an In or Out point in the EDL panel.
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Mark Info Dialog

 

The Mark Info…dialogs allow the user to rename and reset the 
parameters of the selected mark. To view or change the information for a 
particular mark, double-click on the mark or select the Mark Info 
command from the Mark menu.

The top two lines of the dialog list the name of the EDL and the time at 
which the mark is placed. To move the mark to a different location, 
simply enter the desired time. When you exit the dialog, the new 
location will be applied.

Note that EDL marks are automatically numbered from left to right in 
the panel. If you move a mark so that it comes ahead or after another 
mark, all marks will be renumbered from that point.

 

Mode

 

You may set the “mode” of a mark to be Locked or Unlocked. This 
determines how the mark will respond to edits performed using the 
Insert and Delete commands (only!). If the mark is set to Unlocked, then 
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the mark is effectively attached to the audio segment. When moved 
using Insert of Delete, the mark will travel with the sound. This is useful 
when you are using a mark to identify a specific audible feature.

If you are using the mark to locate a point in time rather than an audible 
feature, you can lock the mark to prevent it from moving in response to 
Insert/Delete edits.

The attachment of a mark to an audio segment applies only to the Insert 
and Delete commands. If you use edit functions such as dragging, cut-
and-paste, or text view editing to change the position of a segment, the 
marks will not move with the sound.

 

Mark Types

 

There are eight different types of marks you can use in SonicStudio. 
These have specific uses and are affected by different commands.

 

Start of Track Mark
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Track marks are used in CD mastering to define the start of tracks on the 
finished CD. The Info dialog for a Start of Track mark contains field to 
set the parameters for track offsets, ISRC standard product codes, digital 
copy and emphasis. Flags and other information specific to CD 
mastering applications Use of these fields requires one or the other of the 
CD mastering options, and is described in the manuals for those options.

 

End of Track Mark

 

An End of Track mark is the converse of Start of Track. It is used to mark 
the ending point of CD track. Unlike the Start of Track mark, the Info 
dialog for an End of Track mark does not have any fields specific to that 
type of mark.

 

Index Mark

 

Index marks are used in CD mastering to define points within a track to 
which you can cue a CD player (other than the beginning of the track). 
The Info dialog for an Index mark includes a field which allows you to 
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set offset parameters to be applied in the final master. The use of these 
offsets is described in the manuals for the CD mastering/PQ code 
editing software options.

 

Segment Start
Segment End 

 

Use Segment Start and End marks when you are going to use the marks 
to divide continuous audio into individual segments. These marks are 
used by the commands in the Create Segments submenu of the Edit 
menu.

 

Sync 

 

Sync Marks are used to reference a particular point in a segment. You 
can then use the Offset commands in the Edit menu to move the 
segment so that the position of the Sync Mark aligns with a desired 
point.

There are two options for Offsetting a segment in relation to a Sync 
Mark. With the first of these, Offset Sync Mark To Wherever, you can 
enter a specific time value into the dialog that appears. The segment 
underneath the Sync Mark will move such that the Sync Mark aligns at 
the specified time.

With the Offset Sync Mark To Left Gate command, you can move the 
segment such that the Sync Mark “handle” becomes aligned with the 
current position of the left Gate.

 

Temp and Comment 

 

Temp and Comment Marks serve no special purpose other than to mark 
and label particular points in a soundfile or time line. Typically, you will 
enter a label or comment into the Title field for these marks (see below).
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Title

 

Every mark in an EDL panel has a specific title. Initially, this is the 
number that is automatically assigned to the marks, going from left to 
right in the panel. By entering text into the Title field of the Mark Info 
dialog, you can change this default to any text label you wish to use.

The new label is displayed in the “flag” of the mark in the EDL so you 
can locate specific points by name. In the case of Track Start marks, the 
Title is also transferred directly into the PQ information and becomes the 
title of the cuts in the finished CD master.

 

Analog Black to Marks Dialog

 

This dialog appears in response to the Analog Black to Marks command 
in the Mark menu. This command searches a panel or portion of a panel 
between the left and right Gates.

In the Analog Black to Marks dialog, you can set the dB threshold and 
duration for defining analog black (silence) before placing marks at 
analog black. You can also define the type of marks to be placed in the 
panel by the command.
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In the Threshold field, enter the value in negative decibels (below full-
scale) where you want the system to recognize silence. If you set this 
value too high, then it may place marks so as to cut off portions of 
desired signal. If it is set too low, the system may mistake analog noise 
for signal and fail to place marks where needed.

The Duration field defines how long the signal must stay below 
threshold to be marked. If the audio signal has breaks and pauses in it, 
this setting will be important in preventing these phrasing breaks from 
being interpreted as hard stops.

The type of mark you will want to place depends on the application. If 
you are doing CD mastering, the typically you will want the system to 
place Track Start and Track End marks to be used for generation of PQ 
subcodes. In other applications, it is typical to place Segment Start and 
End marks to divide a recording into individual sound effects or dialog 
phrases, for example. The Mark Type field lets you select which type of 
mark will be place when the command executes.

Once you have defined the parameters of the search, click on the OK 
button or hit the Return or Enter keys to launch the search. The system 
remains fully occupied during this search. If the area you need to search 
is long, this could be quite a while so it’s a good idea to plan accordingly.

 

View Dialogs

Move Wherever Dialog
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The Move Wherever dialog appears when you select the command 
Move to Wherever… from the Move To submenu in the View menu. In 
Waveform or Bar display modes, this dialog lets you specify a precise 
time region to be shown. That panel’s display then zooms to show 
exactly the region you have defined.

There are two ways in which you can specify the area to be viewed. If 
you use the default Set Left and Right Edges option, you will enter the 
exact times for the left and right edges of the display.

If you select the Start Time and Duration option, the labels of the two 
time fields change. In this mode, you will enter a time position for the 
left edge of the display, then enter the duration of time you want to 
show into the lower of the two fields. If you enter time in one mode then 
shift to the other, the numbers in the lower display will change to show 
the equivalent setting.

Once you have defined the region to be viewed, you can exit the dialog 
and perform the command by clicking on the OK button or hitting the 
Enter key.
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DSP Dialogs

Launch Reverse Dialog

 

Selecting the Reverse Sound File command in the DSP menu engages the 
Launch Reverse dialog. There are five fields in this dialog. Begin the 
process of reversal by clicking next to the label “Input Sound File:”. The 
system will scan all mounted sound disks and bring up a list of all 
available soundfiles.

Select the file that you wish to reverse, and close the dialog by clicking 
OK, hitting the Return or Enter keys, or by double-clicking on your 
selection.

If the soundfile you’ve selected is a stereo recording, a second dialog will 
appear to let you select whether to process the left channel, the right 
channel or both. After making your selections, close this subdialog by 
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clicking OK or hitting the Return or Enter keys. The name of the channel 
file for the second channel is automatically entered into the “Stereo 
Mate:” field of the main dialog.

If you wish to process only a portion of the source file, you may 
optionally enter start and end times in the two time fields in the center of 
the dialog. The reverse operation will then be performed only on the 
portion of the file that lies between those two times.

Soundfile reversal is a copy operation that creates a complete new file, 
leaving the original untouched. Before launching the reverse process, 
you must define the name and location of the file that will be created. 
Click next to the label “Output Sound File:”. A dialog will appear to 
allow you to enter a name and select a folder to contain the new file. By 
default, the output file is named the same as the original file with the tag 
“.revxx” where “xx” is a number that increments automatically each 
time you repeat a process.

Once you have selected the source file and defined the output file, the 
Launch button in the main dialog becomes active. When you click this 
button or hit the Return on Enter keys, the system will launch the 
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reversal process in the background. You can observe the progress of 
processing by opening the Background Manager. The reverse process 
will appear in the Port 1 line, which is reserved for file copy operations.

 

Pitch Shift Dialog

 

Requires software option Time Twist/Pitch Shift SS-806

 

Additional details on operation is found in the manual for that option.

This dialog allows the user to select a soundfile to process, name the 
output file, and specify the rate of pitch change. The system will process 
the designated source audio and create a new soundfile containing the 
processed audio.

 

Input Soundfile 

 

Click on this area first to define the soundfile that will be processed. A 
listing of all currently available soundfiles appears, from which you can 
select.

 

Stereo Mate 

 

If the selected soundfile is stereo, the second channel is displayed here.

 

Input
Specifications

Output File

Processing
Parameters
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Start Time 
End Time 

 

Optional. Pitch shift will be performed only on the portion of the source 
soundfile that lies between these two times.

 

Output Soundfile 

 

By default, the dialog that appears will list the name of the source 
soundfile followed by the tag “.ps0001.” You may use this name, or enter 
any name you wish. If you do multiple pitch shift operations on the 
same source file, the numeric portion of the tag increments 
automatically.

 

Ratio

 

The amount of pitch shift applied to the source file is defined as a ratio. 
By default, this is entered as a numeric factor where 1.0 equals no 
change in pitch. Values less that 1.0 indicate shift down in pitch, while 
values greater than 1.0 produce upward pitch shift of the source file.

 

<More Choices>

 

Opens the Pitch Shift Ratio dialog to allow entry of Pitch Shift factor in 
forms other than simple numeric ratio.

 

Quality

 

Tells the pitch shift splicing algorithm how “good” a splice point has to 
be before it will be accepted. The higher the value specified, the better a 
splice must be to be accepted. The system will absolutely NOT do a 
splice if the quality value that the processing determines for the splice is 
below the value set for the Quality parameter. If this value is set too 
high, the system may be unable to find enough acceptable splice points 
to deliver the requested ratio of compression or expansion.
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Save As Default 

 

When you click this button, the current settings in the Pitch Shift dialog 
are saved as the default settings. The default settings are used whenever 
you use any of the “pitch shift edit” commands. These commands (P.S. 
w/CROSS-FADE, etc.) automatically process the sound segment as they 
place it in the Destination panels, using the default values to define the 
pitch shift interval and Quality.

 

Pitch Shift Ratio Dialog

 

Speed Change

 

Expresses the Pitch Shift as a corresponding change in speed. However, 
the actual rate and length of the shifted segment is not altered.

 

Semitones

 

Expresses pitch change in musical semitones.

 

Sampling Rate

 

Expresses pitch change in terms of a corresponding change in sample 
rate

 

Beats

 

The difference of tempo that corresponds to the ratio of shift.
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Launch Twist Dialog

 

Requires software option Time Twist/Pitch Shift SS-806

 

Additional details on operation is found in the manual for that option.

If your system is equipped with a second SSP card for background 
processing, you may edit, etc. as the file is being processed. If there is no 
processing card available, the conversion function can still be performed, 
but other operations will be locked out while it proceeds.

 

Input Soundfile 

 

Click on this area first to define the soundfile that will be processed. A 
listing of all currently available soundfiles appears, from which you can 
select.

 

Stereo Mate 

 

If the selected soundfile is stereo, the second channel is displayed here.

 

Input
Specifications

Output File

Processing
Parameters
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Start Time 

End Time 

 

If you wish, you may define a start and end time. Time 
compression/expansion will be performed only on the portion of the 
source soundfile that lies between these two times.

 

Output Soundfile 

 

You must define a name for the soundfile that will be created. Click here 
to do that. By default, the dialog that appears will list the name of the 
source soundfile followed by the tag “.tt0001.” You may use this name, 
or enter any name you wish. If you do multiple Time Twist operations 
on the same source file, the numeric portion of the tag increments 
automatically.

 

Ratio

 

The amount of time compression or expansion applied to the source file 
is defined as a ratio. By default, this is entered as a numeric factor where 
1.0 equals no change in length. Values less that 1.0 indicate time 
compression, while values greater than 1.0 produce time expansion of 
the source file.

 

Max Per Frame 

 

If a splice is called for in a given frame, but none is acceptable (Quality 
rating equal to or greater than the value set for the Quality parameter), 
the process accumulates a “deficit” of splices that must be made up for 
in later frames. The value of the Max Per Frame parameter tells the 
system how much flexibility it has in the expansion process. The legal 
range is 0.5 to 3.0.
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Silence Thresh

 

Sections of silence in the source file are opportunities for processing. The 
Silence Threshold is a value in decibels that determines what will be 
recognized as silence. If the average energy in a Time Twist frame is 
below this number, then the entire frame will be declared as “silent.”

In a silent frame, the Quality parameter does not apply. The system will 
accept any splice point without regard to its Quality rating.

 

Quality

 

The primary criterion in determining the acceptability of a splice is its 
“quality rating,” which is a numeric value between 0 and 1.

The Quality parameter tells the system how “good” a splice point has to 
be before it will be accepted. The higher the value specified, the better a 
splice must be to be accepted. The system will absolutely NOT do a 
splice if the quality value that the processing determines for the splice is 
below the value set for the Quality parameter. If this value is set too 
high, the system may be unable to find enough acceptable splice points 
to deliver the requested ratio of compression or expansion.

 

Max/Silence

 

During silence, the Time Twist system automatically reduces the setting 
of the Quality parameter to “0,” while regulating the number of splices 
that may be incorporated in a single (silent) frame in order to prevent 
unnatural stretching or chopping of pauses. If the Max/Silence 
parameter is set higher than the Max Per Frame, splices will be 
concentrated in frames that are silent. This can help to avoid audible 
artifacts with active audio, but may have a noticeable effect on the 
pacing of spoken word material.
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Open button
Save button
Save as Default 

 

Use these buttons to save and recall sets of Time Twist settings. When 
you choose Open or Save, a Macintosh file select-type dialog opens to let 
you pick a file of settings to be recalled or to name and place the set you 
are saving.

Save as Default causes the current settings to be saved as the default 
settings. These values appear when the dialog initially opens, but even 
more importantly, they are used exclusively whenever you invoke one of 
the “Time Twist edit” commands such as T.T. w/CROSS-FADE, etc.

These commands work the same as the Insert commands in the Edit 
menu, but the segment of sound is automatically time twisted before its 
placed in the Destination panels. The time ratio is determined by the 
distance between In and Out points in the Source and Destination 
panels, with the inserted segment stretched of squeezed to fit the 
interval in the Destination panels. All other parameters are derived from 
the default settings.

 

Twist Ratio Dialog
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Length Change

 

Specifies change of length as a percentage change from current.

 

Semitones

 

Pitch change if it were not corrected.

 

Time

 

Enter the current length of the soundfile, and the length that you want to 
convert to. The system will calculate and apply the corresponding ratio.

 

Beats

 

Indicates the change in tempo between the source and output files, 
expressed in beats per minute.

 

Reverb Dialog

 

Requires software option Designer Reverberation SS-802

 

Additional details found in the manual for that option.
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Algorithm Selection

 

Designer Reverberation provides 3 separate reverberation algorithms. 
Each of these is optimized for best results with a particular range of 
settings of the Room Size parameter.

 

•

 

Halls -- Best with Size set from 60% to 100%

 

•

 

Medium Rooms -- Best at Sizes of 30% to 70%

 

•

 

Small Rooms -- Optimized for Size setting of 0% to 40%

 

Reverb In/Out button

 

This button switches reverberation processing in and out, making it easy 
to compare the signal with and without reverb. When the dialog opens, 
reverberation is set to “OUT.” In order to hear the reverberated signal, 
the user must click on the button so that it change to “IN.”
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Recall User Setup and Store User Setup

 

The Designer Reverberation option provides the capability of storing 
and recalling an unlimited number of user-defined settings, including 
the selection of reverberation algorithm and the settings of all 
parameters.

To store the current settings in memory, the user clicks on the button 
labeled Save, then uses the standard Mac file-select dialog that then 
appears to define the name of the setup and its location in the Macintosh 
system of files and folders. To recall a user setup, the Open button is 
used, and the procedure is reversed. The operator selects the setup to be 
opened from the file select dialog. All of the settings are loaded into the 
reverberation dialog.

 

Recalling Factory Presets

 

A group of five preset settings defined at the factory are provided in a 
pop-up menu. To change presets, the user clicks on the Select Preset field 
and chooses one of the five presets provided.

 

Input Mute button

 

When the Input Mute button is activated, the input signal is switched off 
(muted), but the reverberation is allowed to continued until it finished 
its current decay. This can be useful in checking the characteristics of the 
late decay, which can be difficult to hear while signal is active.
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Reverberation Parameters

 

The nine sliders in the Reverb Dialog provide complete control over all 
aspects of reverberation.

 

RT60 in s

 

“RT60” is the engineering term for overall reverberation, or decay, time 
expressed in seconds. It is the length of time required for the 
reverberated signal to die down to 60 dB below the maximum. In 
Designer Reverberation, the decay time can be set from a fraction of a 
second up to 12 seconds.

 

Size

 

Apparent size of the space being recreated displayed as a percentage. 
Smaller spaces are shown as low percentages while larger spaces are 
shown as higher percentages. Thus, the factory preset “living room” is 
2.3%, while “cavern” is 84.5%.

 

Delay in ms

 

This a delay time inserted ahead of reverberation. It is typically used to 
simulate larger spaces, in which the sound source is located far from the 
room surfaces. The range of this parameter is 0 to 100 milliseconds.

 

Dens in %

 

Density is one of the principle subjective characteristics that the ear 
identifies in reverberation. This correlates in part to the irregularity of 
surfaces in an acoustic environment. Smooth surfaces yield low density, 
while the bumps and curves of highly ornamented surfaces reflect sound 
in may directions at once, causing rapid build-up in reverb density.
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Low Mult.
Lo cf
High Mult.
Hi cf

 

The four parameters in this group determine how different portions of 
the frequency spectrum decay in relation to overall reverberation time. 
Designer Reverberation divides the reverberant field into two bands, 
Low and High. The relative reverberation time and cutoff frequencies 
are defined separately for each band.

Low in dB and High in dB are not conventional boost/cut filters, but 
actually increase and decrease reverberation time as a multiple of the 
overall (RT60) decay time. In the physical world, reverberation time 
varies with frequency, largely as a function of the absorption 
characteristics of the enclosure surfaces and differential absorption by 
the atmosphere.

Lo cf in Hz and Hi cf in Hz are the cutoff frequencies that apply to each 
band. With these four controls, and enormous range of variation in the 
reverb characteristic can be obtained.

 

Mix in

 

The Mix control determines the blend of dry (unprocessed) versus wet 
(reverberation output) signal. Its value is expressed as the percentage of 
processed signal.

 

Sample Rate Conversion Dialogs

 

Requires software option Basic Sample Rate Conversion SS-520 or 
Varispeed Sample Rate Conversion SS-500.

 

Additional details on the operation sample rate conversion are found in 
the manuals for the specific options.
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Sample Rate Conversion/Varispeed Parameters Dialog

 

When you specify sample rate conversion on record (by selecting the 
checkbox in the Record Sound File dialog), or Varispeed on Playback 
from the Play menu, this dialog appears to define the ratio of conversion.

When you click either the “From” or “To” field, another small dialog 
appears to allow quick conversion between the common standard 
sample rates, or elect to define a custom ratio.

If you select “Custom,” then when you return to the main dialog you 
can enter an arbitrary value in the selected field. Note that you must first 
delete the contents of the field using the keyboard Delete key before you 
can enter the custom value.
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Varispeed Parameters Dialog

 

If you click on the “More Choices” button in the main dialog, this more 
elaborate dialog appears. Change in rate may be expressed in terms of a 
percentage speed change, pitch transposition in musical semitones, 
change from original play time to new time, change from original to new 
tempo, expressed as beats-per-minute, a direct ratio

Select the radio button that corresponds to the way you want to express 
the rate change, then enter the desired value.

 

Percentage Difference

 

Sample rate conversion is a digital process whose resolution is controlled 
by the arithmetic capabilities of the computing engine that performs the 
process. The SSP-3 computes and stores data to 24-bit accuracy.

When the parameters are updated, the system computes the difference 
between the conversion requested and that which the SSP-3 can perform 
in real time. This difference is display in the field % difference. 
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Fewer Parameters 

 

This button returns you to the smaller dialog to specify conversion from 
one sample rate to another.

 

Filter Parameters 

 

This button brings you to the filter parameters dialog.

 

Update Parameters 

 

As discussed, you can specify that change of rate performed by sample 
rate conversion in any of several different ways. When you click on this 
button, the value you have entered is converted so that the same ratio is 
expressed in different ways in the other fields.

 

(Background) Sample Rate Conversion Dialog

 

Sample Rate Conversion can also be performed as a “batch” processing 
function that takes an existing soundfile as its input and creates a new, 
converted file on disk without altering the original. If your system is 
equipped with a second SSP card for background processing, you may 
edit, etc. as the file is being processed. If there is no processing card 
available, the conversion function can still be performed, but other 
operations will be locked out while it proceeds.
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The command Bkg Sample Rate Conversion is found in the DSP menu. It 
brings up a dialog to specify the source file, the conversion ratio, and 
(optionally) the filter parameters that apply.

 

Input Soundfile 

 

Click on this area first to define the soundfile that will be converted. A 
listing of all currently available soundfiles appears, from which you can 
select.

 

Stereo Mate 

 

If the selected soundfile is stereo, the second channel is displayed here.

 

Start Time 
End Time 

 

If you wish, you may define a start and end time. Sample rate 
conversion will be performed only on the portion of the source soundfile 
that lies between these two times.

 

Output Soundfile 

 

You must define a name for the soundfile that will be created. Click here 
to do that. By default, the dialog that appears will list the name of the 
source soundfile followed by the tag “.src0001.” You may use this name, 
or enter any name you wish. If you do multiple conversions on the same 
source file, the numeric portion of the tag increments automatically.

 

Sample Rates 

 

As when doing sample rate on record or playback (varispeed), you must 
define the sample rate of the original file, and the rate to which you wish 
to convert it. Click on each of these fields to bring up the small dialogs 
that specify the standard or customer sample rates.

 

<More Choices> 

 

When you click here, the Bkg SRC Ration dialog appears.
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Filter Parameters 

 

When you click here, the Filter Parameters dialog appears.

 

Bkg SRC Ratio Dialog

 

This dialog functions the same as the Varispeed Parameters. Change in 
rate may be expressed in terms of:

 

•

 

A percentage speed change

 

•

 

Pitch transposition in musical semitones

 

•

 

Change from original play time to new time

 

•

 

Change from original to new tempo, expressed as beats-per-minute

 

•

 

A direct ratio

Select the radio button that corresponds to the way you want to express 
the rate change, then enter the desired value.

 

 The Filter Parameters Dialog

 

The process of sample rate conversion begins by applying a high-
precision digital filter to create a “decimated” version of the original 
audio data. This version is then resampled at the target sample rate to 
create an accurate interpolation between data points.

The low-pass filter that is used for decimation is very precise. The user 
has a great deal of control over the actual realization of this filter.
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The large form of the Sample Rate conversion/Varispeed Parameters 
dialog includes a button labeled “Filter Parameters.” This button brings 
up a dialog to set different aspects of the filter implementation.

 

 DC Level Gain

 

The decimation filter used in sample rate conversion is an FIR type, a 
multi-tap delay that approximates the response of the ideal filter. 
Because the decimation calculations must be performed in real time, the 
number of taps available for the filter is limited, and the theoretically 
infinite impulse response must be abbreviated.

For computational efficiency, SonicStudio uses a direct truncation of the 
ideal prototype response. This type of filter is very accurate, but exhibits 
amplitude ripple near the cutoff frequency that is known as the “Gibbs 
Phenomenon.”

As a result of this ripple, source material containing high frequencies 
recorded at high signal levels may exhibit clipping as it passes through 
the decimator. The DC Level Gain parameter reduces gain at the input of 
the conversion to prevent this clipping. This reduces the overall level of 
the converted audio.

If the source material does not contain strong high frequencies, the DC 
level Gain may be set to a value of “1,” resulting in unity gain, without 
adversely affecting audio.
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Filter Frequency 3 dB point

 

The maximum value for the cutoff frequency of the decimation filter is 
the Nyquist frequency of the source, which is 1/2 the sample rate. The 
actual cutoff frequency used for the filter is expressed as a multiple of 
the Nyquist rate.

Although the system provides for setting of this parameter from 0 to 1.0, 
normal values are in the range of .9 to 0.95. For example, the default of 
0.9070295 is set up for conversion from 48 kHz or 44.1 kHz source 
material. The minimum cutoff frequency of the filter in kilohertz then is:

 

(44.1 * 0.5) * 0.9070295 = 20.000 kHz

 

A slightly lower factor could be used at 48 kHz sample rate, while 
keeping the filter cutoff at or above 20 kHz.

 

Filter Sharpness Beta

 

In a digital filter of the type used for sample rate conversion, there is a 
trade-off between the sharpness of the filter and the amount of 
attenuation in the stopband. SonicStudio uses a 

 

Kaiser window

 

 
implementation which has a constant, ß (Beta), that defines this trade-
off.

Lower values for the Beta parameters mean a sharper cutoff, but less 
attenuation in the stopband, while lower values translate into a more 
gentle rolloff, with more optimal stopband attenuation.

A low value for Beta may result in aliasing problems caused by the 
reflection of signal components below the Nyquist frequency into the 
trans-Nyquist region. Setting the Beta to a high value, on the other hand, 
will broaden the transition band, and could result in problems with 
frequencies that are near the filter cutoff point, but beneath the Nyquist 
frequency.

 

Window Size

 

The window size presents a three-way trade-off between the accuracy of 
conversion ratio, filter response, and signal processing power required.
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The greatest accuracy of conversion ratios is provided by low window 
size. Higher values yield better performance in the decimation filter, but 
at the expense of a larger error factor (% difference) in the conversion 
factor realized versus that requested.

In addition, higher values for Window Size consume larger amounts of 
processing power. Depending on the conversion ration requested, this 
can result in the SSP-3 engine being unable to deliver the requested 
conversion in real time.

 

NoNOISE

 

®

 

 Dialogs

 

Requires NoNOISE options, NN-101, 102, 103, 104, 105, 106.

 

NoNOISE is an extensive and distinct environment of specialized tools 
for audio restoration. Complete descriptions of the commands and 
dialogs used for NoNOISE are found in the NoNOISE Users Manual. 
Description of these is beyond the scope of this document.
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Menu Command Keyboard Equivalents

 

Introduction

 

SonicStudio’s menu commands and dialogs provide complete control 
over all audio transfer, editing, and processing functions. For the 
experienced user, however, it is often faster and more convenient to use 
the keyboard computer keyboard to control the system.

SonicStudio provides two kinds of keyboard command equivalents.

 

•

 

Sonic Keys

 

 are permanent key assignments that are built into the 
application and cannot be changed by the user.

 

•

 

Quick Keys

 

 are user-changeable keyboard commands that use 
QuicKeys

 

™

 

 from CD Software.

This utility program is provided in many of the SonicStudio package 
configurations and is highly recommended for all users. 

These built-in commands and utility functions can greatly speed your 
use of the system. If you do not have QuicKeys installed on your 
computer, we recommend you do so.
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Built-In Keyboard Commands

 

There are a number of keyboard command equivalents that are built into 
the system. Most of these are “command keys”, invoked by holding 
down the “command” (

 

 

 

) or “apple” key on either side of the spacebar 
while pressing another key. Command keys are displayed in the menu 
next to the commands they affect, so it is always easy to find out what 
they are. Letter keys are shown, in capitals, as they appear on the key 
top.

 

Menu Commands 

 

File Menu Command Keys

 

command - W Close

command - S Save

command - Q Quit

 

Edit Menu Command Keys

 

command - Z Undo

command - X Cut

command - C Copy

command - V Paste

 

EDL Menu Command Keys

 

command - Y Display selecte panel(s) in Waveform mode

command - T Display selected panel(s) in Text mode

command - B Display selected panel(s) in Bar mode

command - H Display selected panel (s) in NoNOISE Estimate 
mode

command - R Refresh Plot



SonicStudio Version 5.2 A-3

Menu Command Keyboard Equivalents

Play Menu Command Keys

 

command - space Play between Gates

command - / Enter Reel-Rock (Scrub) mode

 

Mark Menu Command Keys

 

command - [ Place IN point

command - ] Place OUT point

command - \ Find & Set Points (set edit points at nearest 
previous edit)

 

View Menu Command Keys

 

command - I Zoom In

command - O Zoom Out

command - P Zoom to Previous View

left arrow Move Backward

right arrow Move Forward

up arrow Zoom In

down arrow Zoom Out

 

EDL Commands

 

There are a few key commands that can be used while the EDL is open.

S Set selected panel(s) to Source edit group

D Set selected panel(s) to Destination edit group

command - A Select all segments in selected panel(s)

command - D De-select all segments in selected panel(s)
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QuicKeys

 

Quick Keys are implemented through CE Software’s QuicKeys™ utility. 
This is useful application runs in the background, and when a specific 
key or keys are pressed, it executes the specified command in 
SonicStudio.

The principle advantage that Quick Keys have over built-in keyboard 
commands is the key assignments can be easily changed by the user, and 
new commands specified. This powerful customization capability lets 
you tailor the system to fit your task and the way you work.

A standardized set of Quick Keys is delivered with SonicStudio. This set 
has evolved over several years of experience with the system in many 
different contexts, and has been found to be broadly useful for many 
applications.

 

Transport Panel Quick Keys

 

When the Transport Panel is up on screen, you may use the first three 
keys on the keyboard numeric keypad, together with the option key, to 
cue the EDL to any of the three cue memories.

Additionally, you may use the sequence below to halt a recording in 
progress.

option - F9 Halt recording in progress


